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About this guide
This chapter covers the following topics:
 l What this guide covers (page 10)
 l Conventions (page 10)
 l About the BD FACSymphony™ A1 documentation (page 11)
 l Instrument technical support (page 11)
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What this guide covers
This guide describes the procedures necessary to operate and maintain your 
BD FACSymphony™ A1 flow cytometer. Because many cytometer functions are 
controlled by BD FACSDiva™ software, this guide also contains information about 
software features required for basic cytometer setup and operation. 

This guide assumes you have a working knowledge of basic Microsoft® Windows® 
operation. If you are not familiar with the Windows operating system, see the 
documentation provided with your computer.

Conventions

Introduction

The following table lists the safety symbols used in this guide to alert you to potential 
hazards.

Safety symbols

Symbol Meaning

Caution! Identifies a hazard or unsafe practice that could result in data loss, 
material damage, minor injury, severe injury, or death

Biological hazard

Electrical hazard

Laser hazard
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Chapter 1  About this guide

About the BD FACSymphony™ A1 
documentation

Introduction

This topic describes the documentation available with the BD FACSymphony™ A1 flow 
cytometer.

Documentation USB Card 

This user's guide is provided in PDF format on the Documentation USB card. The 
BD FACSymphony™ A1 Flow Cytometer Site Preparation Guide is also on the card. It 
contains specifications for:
 o Cytometer weight and size
 o Temperature
 o Electrical requirements

Help system         

The help system installed with BD FACSDiva™ software includes the documents listed 
below. Access the BD FACSymphony™ A1 help system from the Help menu in the 
BD FACSDiva™ software. Internet access is not required to use the help system.

The help system includes the following documents:
 l BD FACSDiva™ Software Reference Manual: Includes instructions or descriptions for 

installation and setup, workspace components, acquisition controls, analysis tools, 
and data management. Access this manual from the BD FACSDiva™ Software Help 
menu (Help > Documentation > Reference Manual), or by double-clicking the 
shortcut on the desktop. 

 l BD Cytometer Setup and Tracking Application Guide: Describes how to use the 
BD® Cytometer Setup and Tracking (CS&T) features in BD FACSDiva™ software. 

Instrument technical support

Introduction

This topic describes how to get technical assistance.

   11
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Contacting technical support

If technical assistance is required, contact your local BD Biosciences customer support 
representative or supplier. 

When contacting BD Biosciences, have the following information available:
 l Product name, part number, and serial number
 l Version of BD FACSDiva™ software you are using
 l Any error messages
 l Details of recent system performance

To contact customer support:
 1. Go to bdbiosciences.com.
 2. Select your region. You will see information in your local language. 
 3. Click Go. 
 4. Click the Support link for details for your local region. 

12   
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Introduction
This chapter covers the following topics:
 l System overview (page 14)
 l Cytometer overview (page 15)
 l Control panel (page 17)
 l Fluidics system (page 18)
 l Sheath and waste tanks (page 25)
 l Optics (page 26)
 l Workstation (page 28)



   BD FACSymphony™ A1 Flow Cytometer User's Guide

System overview

About the system

The BD FACSymphony™ A1 system includes the BD FACSymphony™ A1 flow 
cytometer, BD FACSDiva™ software running on the system workstation, the optional 
BD FACSFlow™ supply system (FFSS), and the optional BD High Throughput Sampler 
(HTS). Each component is described in detail in the following sections.

In addition, the BD® Small Particle Detector (SPD) is an optional side scatter detector 
optimized to improve resolution of small particles such as extracellular vesicles. For 
more information, see Small Particle Detector (page 129). 

 

TM

321

Number Components

1 Sheath and waste tanks

2 BD FACSymphony™ A1 flow cytometer

3 Computer workstation
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Cytometer overview

Introduction

The BD FACSymphony™ A1 flow cytometer is an air-cooled multi-laser benchtop flow 
cytometer with the ability to acquire 14 or 16 fluorescent parameters. It uses 
fixed-alignment lasers that transmit light through a flow cell to collect and translate 
the resulting fluorescence signals into electronic signals. Cytometer electronics 
convert these signals into digital data.         

Components

The following figures show the main components on the front and right side of the 
BD FACSymphony™ A1 flow cytometer. The descriptions are listed in the tables. 

 

TM

5

4

3

2

1

Number Component

1 Heat ventilation slots (top)

2 Control panel
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Number Component

3 Sample injection port (SIP)

4 Heat ventilation slots (left side)

5 Optics access door (polygon detector arrays)
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Number Component

1 Red laser detector array access panel

2 Power button

3 Electrical plug

4 Fluidic sensor ports

5 Air and fluidic ports

6 USB port for Small Particle Detector to workstation
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Caution! Do not place any objects on top of the instrument. Blocking the ventilation 
may cause the instrument to overheat.

Caution: Electrical Hazard! Do not place liquids on top of the instrument. Any spill 
of liquid into the ventilation openings could cause electrical shock or damage to the 
instrument.

Control panel

Overview

The fluidics display controller enables the monitoring of the sheath tank level, waste 
tank level, and air pressure status through a combination of status LEDs and text 
display. It also controls sample flow rate and fluidic controls.

The following figure shows the components in the control panel, which are listed in the 
table.

6

543

21

Number Component

1 System status and activity bar

2 Fluid control buttons

3 Sample flow rate buttons
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Number Component

4 Sample fine adjust buttons

5 MODE button

6 Touch screen and status display

More information
 l Fluidics system (page 18)
 l Optics (page 26)

Fluidics system

Introduction

The fluidics system carries the sample out of the sample tube and into the 
interrogation region of the flow cell. Cells are carried in the sample core stream in 
single file and measured individually.

Note: If your system has the BD® HTS option, see the BD® High Throughput Sampler 
User’s Guide for additional information on the sample flow rates and fluidic controls.

System indicators

There are two system indicators (System Status and Activity) on the control panel as 
well as Sheath Tank Air Pressure, Sheath, and Waste indicators on the graphic display.
 l System Status bar. Shows the status of the system by displaying a green, yellow, or 

red LED indicator. The following table describes the LED indicators, conditions that 
trigger them, and any action that must be taken.

LED 

color

Status Action Condition

Green Good None Good

Yellow Caution!  Sheath and/or 
waste tanks need attention.

Check tank levels Sheath low and/or 
waste nearly full
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LED 

color

Status Action Condition

Red Caution!  Take immediate 
action.

 l Empty waste 
tank

 l Fill sheath tank

 l Check air 
pressure 

Sheath empty 
and/or waste full

Air pressure is out of 
specification

System status is also displayed on the Status screen. See Status screen (page 21) 
for a description of the Status screen.

 l Activity. Shows whether the cytometer power is on and the status of acquisition. 
The following table describes the indicator LEDs, and status that triggers them.

Indicator LED color Status

Steady pulse blue Cytometer is powered on

Fluctuates blue Forward scatter is registering cells or particles

Fluid control

The three fluid buttons (RUN, STANDBY, and PRIME) control the fluidics subsystem.
 l RUN Pressurizes the sample tube to transport the sample through the sample 

injection tube and into the flow cell.
The RUN button is green when the sample tube is on and the support arm is 
centered and the sample tube is pressurized. When the tube support arm is moved 
left or right to remove a sample tube, the cytometer switches to an automatic 
standby status to conserve sheath fluid, and the RUN button changes to orange.
The RUN button will also turn orange if the sample tube is cracked or the BAL seal is 
bad. See Troubleshooting (page 109).

 l STANDBY            Stops fluid flow to conserve sheath fluid.           
When you leave the cytometer for more than a few minutes, place a tube 
containing less than 1 mL of deionized (DI) water on the sample injection port (SIP) 
and press STANDBY.

 l PRIME            Prepares the fluidics system by draining and filling the flow cell with sheath 
fluid.           

Note: Remove sample tubes during the prime cycle.

   19
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The fluid flow initially stops, and pressure is reversed to force fluid out of the flow 
cell and into the waste container. After a preset time, the flow cell fills with sheath 
fluid at a controlled rate to prevent bubble formation or entrapment. At 
completion, the cytometer switches to standby mode.

Sample flow rate control

The three flow rate buttons (LOW, MED, HIGH) control the sample rate through the 
flow cell. The three fluidic control buttons (RUN, STANDBY, PRIME) enable you to 
control the sample acquisition rate.

21

Number Component

1 Sample flow rate buttons

2 Sample fine adjust buttons

When sample adjust is set to 250 (as shown on the status screen on the control panel) 
the sample flow rates at the Low, Med, and High settings are approximately 12, 35, 
and 60 µL/min of sample, respectively. Each time you press one of the SAMPLE ADJ 
buttons, the fine adjust of the indicated sample increases or decreases by 10. The 
following table shows the approximate sample flow rate range for low, medium, and 
high.

Settings Sample flow rate (µL/min)

Low 6–24

Med 17.5–70

High 30–120
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Status screen

The status screen display is a touchscreen color LCD screen which displays operational 
data while the system is running and toggles between two different displays: Normal 
Mode and Setup Mode.

Normal Mode displays the current settings of the Fine Adjust Potentiometer, the three 
programmable potentiometer Set Points, Sheath Tank Pressure Status, Sheath Level, 
and Waste Level while the system is running.

The Normal Mode screen is shown in the following illustation.

SETPOINT 1  SETPOINT 2  SETPOINT 3
SETPOINT

FUNCTION

SETUP

MODE

FINE ADJUST PRESSURE

HIGH

GOOD

LOW

SHEATH WASTE

7654

32

1

Number Definition

1 Fine Adjust. Shows the current setting of fine adjust. The slider enables quick 
changes to the potentiometer setting by moving the slider up or down. Fine adjust 
can be set in increments of 10 from 0 to 500. The normal set point is 250. The 
last value persists, even after cytometer shutdown.

2 Sheath Level. Shows range from 0 to 100. The display line decreases from top to 
bottom in sequences of 20% from full level. System status turns yellow at 20%, 
and red at 0%.

3 Waste Level. Shows range from 0 (empty) to 100 (full). The display line 
increases from bottom to top in sequences of 20%. System status turns yellow at 
80%, and red at 100% full.
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Number Definition

4 Setpoint. Stores up to three potentiometer setpoints. A setpoint is set by tapping 
the Setpoint Function button, moving the Fine Adjust slider up or down to the 
desired point, and tapping one of the setpoint buttons. The Setpoint enables you 
to store three different settings and quickly change between them.

5 Setpoint Function. Button enables the setting of a Setpoint.

6 Setup Mode. Button to enter Setup Mode (Setup Mode can also be entered by 
pushing the Mode button on the control panel).

7 Alarm Silenced Indicator. When the alarm sounds are silenced, the indicator will 
turn on and display the text Alarm Silenced.

Setup Mode displays the current settings of Sound, FFSS Mode, and Altitude while the 
system is running. The Setup Mode screen is shown in the following illustation.

SETUP
ALTITUDE

(METERS)

SOUND

FFSS

SW Revision Ø6

2000

1500

1000

500

0

-500

OFF

EXIT SETUP

4

3

2

1

Number Definition

1 Sound. Turns the warning alarm sounds on or off. To turn on the alarm, slide the 
slider to the left position. To turn off the alarm, slide the slider to the right 
position. A green light indicates the alarm is active. A red light indicates the 
alarm is inactive.

2 FFSS Mode. Turns FFSS Mode on or off. To turn on FFSS Mode, slide the slider to 
the left position. To turn off FFSS Mode, slide the slider to the right position. A 
green light indicates FFSS Mode is active. A red light indicates FFSS Mode is 
inactive. 

3 Exit Setup.  Button to exit Setup Mode.
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Number Definition

4 Altitude. Shows the current setting of Altitude. The slider enables quick changes 
to the Altitude setting by moving the slider up or down. Altitude can be set from 
(-500 to 2000) meters. Sliding the slider down to the Off position turns the air 
pressure warning off.

Fluidic alarms and the Mode button

The fluidic alarms are triggered by the waste and sheath fluid levels in the tanks and 
by low or high sheath tank air pressure levels. The alarms sound when the waste tank is 
nearly 100% full and the sheath tank is empty. The fluidic alarms and system status 
will also show warnings when you start up the cytometer until the tank pressure 
reaches the correct level.

To silence the alarm sounds, press the Setup Mode in the touchscreen. Slide the Sound 
slider to the right. To turn the alarm sounds back on, slide the Sound slider to the left. 
If the alarm sounds are turned off, the Normal Mode screen will also indicate the 
sounds are off. 

Caution! Turning off the Sound may result in overflow of waste and you may run 
out of sheath. 

Note: The system status indicators are not affected by the alarm sounds on/off state.

Note: When the cytometer is in FFSS mode, both visual and audible alarms are 
deactivated. 

Note: The function of the system is sensitive to air pressure for flow rates. The system 
needs to know the altitude, in meters, of the location of the system in order to 
accurately report the air pressure. 

Sample injection port (SIP)

The SIP is where the sample tube is installed. The SIP includes the sample injection 
tube (SIT) and the tube support arm. Samples are introduced through a stainless steel 
injection tube equipped with an outer droplet containment sleeve. The sleeve works in 
conjunction with a vacuum pump to eliminate droplet formation of sheath fluid as it 
backflushes from the sample injection tube.
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3

2

1

Number Component

1 Outer sleeve

2 Sample injection tube (SIT)

3 Tube support arm

Sample injection tube (SIT).      Stainless steel tube that carries sample from the sample 
tube to the flow cell. This tube is covered with an outer sleeve that serves as part of 
the droplet containment system.

Tube support arm. Arm that supports the sample tube and activates the droplet 
containment system vacuum. The vacuum is on when the arm is positioned to the side 
and off when the arm is centered.

Note: If a sample tube is left on the SIP with the tube support arm to the side 
(vacuum on), the sample will be aspirated into the waste container.

Cautions when using the HTS option
Caution: Biohazard! When using the BD FACSymphony™ A1 flow cytometer with the 
HTS, ensure that the HTS is completely pushed into the operating position before 
removing the droplet containment module (DCM) sleeve or disconnecting the sample 
coupler from the SIP. This is to avoid accidental leakage of potentially biohazardous 
liquids directly onto the instrument. With the HTS in the proper location, the 
containment dish with padding is directly below the SIP.
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Caution! If you are using the HTS option, always slide the HTS mount slowly to 
prevent sample cross-contamination when the wells are full. Never move the HTS 
when it is in operation.

Caution! Do not lean on or put any weight on the HTS as it could damage the 
instrument.

Droplet containment module         

The DCM prevents sheath fluid from dripping from the SIP and provides biohazard 
protection.

The DCM vacuum is activated when the tube support arm is moved to the side. Sheath 
fluid is aspirated as it backflushes the sample injection tube. This backflush helps 
prevent carryover of cells between samples.

Sheath and waste tanks

Introduction

This topic describes the sheath and waste tanks. The sheath and waste tanks are 
outside the cytometer and can be positioned on the floor.

Note: Only BD service engineers should change the location of the sheath and waste 
tanks.

If you are using the BD FACSFlow™ supply system (FFSS), see the BD FACSFlow™ 
Supply System User’s Guide for more information.

Sheath tank

The sheath tank has a capacity of 10 L. Sheath fluid is filtered through an in-line, 
interchangeable filter that prevents small particles from entering the sheath fluid 
lines. An alarm sounds when the tank is empty.

Caution! Do not fill the sheath tank to its maximum capacity. When an overfull 
tank is pressurized, erratic cytometer performance can result.

Waste tank

The waste tank has a capacity of 10 L. An alarm sounds when the tank is full.
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Cable management

Arrange the cables, air lines, and fluidics lines from the instrument to the sheath and 
waste tanks away from high traffic area. Also ensure that the cables and lines are 
placed so they do not interfere with normal instrument operation.

Routing the cables and lines from the back of the instrument to the underside of the 
table and then to the tanks is preferable. Any excess lines or tubing should be loosely 
coiled but out of the way of the tanks.

More information
 l Preparing the sheath tank (page 31)
 l Preparing the waste tank (page 36)
 l Status screen (page 21)
 l Fluidic alarms and the Mode button (page 23)

Optics

Introduction

This topic describes the optical components for the BD FACSymphony™ A1 flow 
cytometer including:
 l Detector arrays
 l Lasers
 l Optical filters
 l Signal detectors

Detector arrays         

The BD FACSymphony™ A1 detector arrays consist of polygons. Each polygon can be 
configured with one to six fluorescent detectors. The configuration of detectors may 
limit the actual number of detectors on each polygon. To access the red laser detector 
array, see Accessing the red laser detector array (page 61).

Lasers        

The BD FACSymphony™ A1 flow cytometer is configured with four lasers  as listed in 
the following table. 
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Laser Wavelength (nm) Power (mW)

Blue 488 100

Red 637 100

Violet 405 100

Yellow Green 561 100

Optical filters

Optical filters attenuate light or help direct it to the appropriate detectors. The name 
and spectral characteristics of each filter appear on its holder.

There are two types of optical filters in the BD FACSymphony™ A1:
 l Longpass dichroic filters (LPs) Transmit wavelengths at or longer than the specified 

value and reflect all light below the specified wavelength.
 l Bandpass filters (BPs) Pass a narrow spectral band of light.

When dichroic filters are used as steering optics to direct different color light signals to 
different detectors, they are called dichroic mirrors. Longpass dichroic mirrors transmit 
longer wavelengths to one detector while reflecting shorter wavelengths to a different 
detector.

The BD FACSymphony™ A1 flow cytometer polygon detector arrays use dichroic 
longpass mirrors on the inside, and bandpass filters on the outside of the filter holders.

Signal detectors

Light signals are generated as particles pass through the laser beam in a fluid stream. 
When these optical signals reach a detector, electrical pulses are created that are 
then processed by the electronics system.

There are two types of signal detectors in the BD FACSymphony™ A1 flow cytometer: 
 l Photomultiplier tubes (PMTs).            Used to detect the weaker signals generated by side 

scatter and all fluorescence channels. These signals are amplified by applying a 
voltage to the PMTs.           

 l Photodiodes.            Less sensitive to light signals than the PMTs. A photodiode is used to 
detect the stronger forward scatter (FSC) signal.          
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More information
 l Optical filter theory (page 98)
 l About configurations (page 122)

Workstation

Introduction

This topic describes the components of the BD FACSymphony™ A1 workstation.

Workstation components

Acquisition, analysis, and most instrument functions are controlled by the 
BD FACSymphony™ A1 workstation. It includes a PC and one or two monitors. 

Your workstation is equipped with the following:
 l Microsoft Windows operating system
 l BD FACSDiva™ software version 9.0.2 or later for data acquisition and analysis 
 l Software documentation including the help system

More information
 l About the BD FACSymphony™ A1 documentation (page 11)
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Cytometer setup
This chapter covers the following topics:
 l Starting the cytometer and computer (page 30)
 l Preparing the sheath tank (page 31)
 l Removing air bubbles (page 34)
 l Preparing the waste tank (page 36)
 l Preparing the fluidics (page 39)
 l About the optical filters and mirrors (page 40)
 l Custom configurations and baselines (page 42)
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Starting the cytometer and computer

Introduction

This topic describes how to start the cytometer and turn on the computer.

Note: If your system is using the BD FACSFlow™ supply system, make sure that the 
BD FACSFlow™ supply system is powered on before the cytometer.

Procedure

To start the cytometer:         
 1. Turn on the power to the flow cytometer. 

Allow 30 minutes for the optical system temperature to stabilize.

Caution! Failure to warm up and stabilize the instrument could affect sample 
data.

 2. Turn on the computer and log in to Windows.

Note: You can turn on the power to the flow cytometer and the workstation in any 
order.

 3. Start BD FACSDiva™ software by double-clicking the shortcut on the desktop, and 
log in to the software.

 4. Check the Cytometer window in BD FACSDiva™ software to ensure that the 
cytometer is connected to the workstation.
The cytometer connects automatically. While connecting, the message Cytometer 
Connecting is displayed in the status area of the Cytometer window. When 
connection completes, the message changes to Cytometer Connected.
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If the message Cytometer Disconnected appears, see Electronics troubleshooting 
(page 116).

Preparing the sheath tank

Introduction

This topic describes how to prepare the sheath tank. 

Note: If your system is using the BD FACSFlow™ supply system, see the BD 
FACSFlow™ Supply System User’s Guidefor more information.

When to check the sheath tank

Check the fluid levels in the sheath tank every time you use the cytometer. This 
ensures that you do not run out of sheath fluid during an experiment.
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Sheath tank components

7

6

5

4

3

2

1

Number Component

1 Cap handle

2 Filter assembly

3 Sheath fluid line (blue) to sheath tank

4 Air line (green)

5 Alarm sensor

6 Clamp knob

7 Vent valve
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Procedure

Note: Be careful to avoid damaging the alarm sensor line or any of the tubing  when 
disconnecting and filling the sheath tank.

To prepare the sheath tank:
 1. Verify that the flow cytometer is in standby mode. 

Press the STANDBY button on the control panel if necessary.
 2. Disconnect the green air line and blue sheath fluid line from the sheath tank.
 3. Disconnect the alarm line from the alarm sensor socket by pulling lightly on both 

ends of the plug. See the following illustration.    

2

3

1

Number Component

1 Alarm sensor socket

2 Alarm sensor line

3 Disconnect at this point

 4. Depressurize the sheath tank by pulling up on the vent valve.          
 5. Remove the sheath tank lid. 

Unscrew the clamp knob and push down to loosen, if necessary. Tilt the cap to the 
side to remove it from the tank.

 6. Add up to 10 L of sheath fluid, such as BD FACSFlow™ solution, to the sheath tank. 

Note: 10 L will reach the interior line on the sheath tank. Do not fill the sheath tank 
further.

 7. Replace the sheath tank lid. 
 8. Make sure the gasket on the inside lip of the sheath lid is seated correctly and has 

not slipped out of position.

Note: If the gasket is not seated correctly, the tank will not pressurize properly.
 9. Close the sheath lid and tighten the clamp knob to finger-tight. 
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 10. Reconnect the green air line, alarm line and the blue sheath line.
Ensure that the blue sheath fluid line is not kinked.

Note: Make sure the alarm sensor socket is off the ground by looping the line 
through the handle of the sheath tank.

More information
 l Removing air bubbles (page 34)
 l Changing the sheath filter (page 52)
 l Cleaning or replacing the sheath gasket  (page 60)

Removing air bubbles

Introduction

This topic describes how to remove trapped air bubbles in the sheath filter and the 
sheath line. Air bubbles can occasionally dislodge and pass through the flow cell, 
resulting in inaccurate data.

Note: Perform this activity every time the sheath tank is refilled. 

Procedure

To remove air bubbles:
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 1. Check the sheath filter for trapped air bubbles.

1

2

3

Number Components

1 Cytometer fluid line (roller clamp not visible)

2 Vent fitting

3 Vent line

 2. If bubbles are visible, gently tap the filter body with your fingers to dislodge the 
bubbles and force them to the top.

Caution! When removing air bubbles, do not vigorously shake, bend, or rattle the 
sheath filter or you might damage it.

 3. Direct the vent line into a beaker and press the small button at the end of the vent 
fitting against the side of the beaker until a steady stream of fluid empties from 
the filter.

 

2

1
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Number Components

1 Button

2 Vent fitting

 4. Tilt the filter and verify that no trapped air remains in the filter. 
 5. Repeat steps 3  and 4 until no air is observed in the filter.
 6. Check the sheath line for air bubbles.
 7. Open the roller clamp at the fluidics interconnect (if necessary) to bleed off any air 

in the line. Collect any excess fluid in a waste container.

Note: The roller clamp can be found close to the fluidics ports of the cytometer.
 8. Close the roller clamp.

Preparing the waste tank

Introduction

This topic describes how to prepare the waste tank. Prevent waste overflow by 
emptying the waste tank daily or whenever the system status indicator turns yellow.

Note: If your system is connected to the FFSS, see the BD FACSFlow™ Supply System 
User’s Guide for more information.

Caution: Biohazard! All biological specimens and materials coming into contact 
with them are considered biohazardous. Handle as if capable of transmitting 
disease. Dispose of waste using proper precautions and in accordance with local 
regulations. Never pipette by mouth. Wear suitable protective clothing, eyewear, and 
gloves.

Waste tank components

The following figure shows the main components of the waste tank.
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3

4

51

2

Number Component

1 Moisture trap

2 User replaceable cap

3 Air line

4 Alarm sensor

5 Waste fluid line

Biological precautions
Caution: Biohazard! Contact with biological specimens and materials can transmit 
potentially fatal disease.

To prevent exposure to biohazardous agents:
 l Put the cytometer in standby mode before disconnecting the waste tank to avoid 

leakage of biohazardous waste.
 l Always disconnect the waste tank from the cytometer before you empty it. Wait at 

least 30 seconds for pressure to dissipate before you remove the waste cap or 
sensor.
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 l Expose waste tank contents to bleach (10% of total volume) for 30 minutes before 
disposal.

 l Do not wet the waste tank cap. If wet, the filter in the cap will cause the tank to 
malfunction. To keep the cap dry, place it on the bench label side up when it is not 
on the tank. 

Procedure

To prepare the waste tank:
 1. Verify that the flow cytometer is in standby mode. 

Press the STANDBY button on the control panel if necessary.
 2. Disconnect the orange waste tubing from the waste tank. 
 3.  1.  1. Disconnect the alarm line from the alarm sensor socket by pulling lightly on both 

ends of the plug. See the following illustration.

2

3

1

Number Component

1 Alarm sensor socket

2 Alarm sensor line

3 Disconnect at this point

Keep the lid and moisture trap on the waste tank until you are ready to empty it.
 4. Remove the lid and moisture trap before emptying the waste tank. Keep the cap 

label side up at all times. Empty the waste tank.

Caution! The waste tank is heavy when full. When emptying it, use good body 
mechanics to prevent injury.

 5. Add approximately 1 L of bleach to the waste tank and close it. Reattach the 
moisture trap and lid.

 6. Reconnect the orange waste tubing and make sure it is not kinked.
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 7. Reconnect the black alarm sensor line.

Note: Make sure the alarm sensor socket is off the ground by looping the line 
through the handle of the waste tank.

Preparing the fluidics

Introduction

This topic describes how to prepare the fluidics system.

When to prime the fluidics

Sometimes, air bubbles and debris may become lodged in the flow cell. This is 
indicated by excessive noise in the forward and side scatter parameters (FSC and SSC, 
respectively). In these cases, it is necessary to prime the fluidics system. Priming 
introduces air to the flow cell. Performing the following procedures should minimize 
the need for priming and make priming more effective when needed.

Procedure

Start up the fluidics:
 1. Turn on the computer and instrument as described in Starting the cytometer and 

computer (page 30).
 2. Install a tube with 3 mL of 1.5% dilution of BD® Detergent Solution Concentrate 

on the SIP and put the tube support arm underneath the tube. 

Note: The BD Detergent Solution Concentrate must be diluted before use. Mix one 
full 15 mL bottle of BD Detergent Solution Concentrate into 985 mL of DI water to 
make 1 L total.    

 3. Press RUN and HIGH on the cytometer fluid control panel. Run for 10 minutes.
 4. Remove the tube of detergent from the SIP and replace with a tube containing 

3 mL of DI water.
 5. Press RUN and HIGH on the cytometer fluid control panel. Run for 10 minutes.

Determine whether or not the fluidics need to be debubbled by priming:
 1. Open or create an experiment to view BD® CS&T Beads. For details on using the 

beads, see Running a performance check (page 67).          
 2. Create a new tube in the experiment.
 3. Load a tube of BD® CS&T Beads.             
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 4. Press RUN and LOW on the cytometer fluid control panel.             
 5. Observe the plots for the scatter channel and fluorescent channels. There should 

be two distinct peaks for each scatter channel and three distinct peaks for each 
fluorescent channel. The coefficient of variation (CV) for bright peaks should be 
narrow. If either the CVs are very wide on a detector or no signal is observed, the 
fluidics need to be primed as described in the following procedure.          

To prime the fluidics:

 1. Move the tube support arm to the side
 2. Remove tube from the SIP or leave the HTS connected to the SIT. 
 3. Press the PRIME fluid control button to force the fluid out of the flow cell and into 

the waste container. Once drained, the flow cell automatically fills with sheath 
fluid at a controlled rate to prevent bubble formation or entrapment. The 
STANDBY button turns amber after completion.

 4. When Standby light is on, install a tube of DI water or leave the HTS hooked up to 
the SIT.

 5. Press the RUN fluid control button and run for 10 seconds.             
 6. Press the PRIME button immediately followed by the RUN button.
 7. Repeat step 6 ten times. If more than 2 seconds pass between Prime and Run in 

step 4, restart the procedure       
 8. Install a 12 × 75 mm tube with 1 mL of DI water on the SIP and place the support 

arm under the tube. Leave the cytometer in standby mode.             

More information
 l Cytometer troubleshooting (page 110)

About the optical filters and mirrors

Introduction

This topic provides a description of the optical filters and mirrors.

Filter and mirror configurations

Each detector has an optic holder in front of it. The optic holders are labeled with 
numbers indicating the wavelengths of the bandpass filter and longpass dichroic mirror 
they contain (for example, 780/60 and 750 LP, respectively). The optic holder in front 
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of the last detector in the detector array contains only a bandpass filter and is marked 
accordingly. 

1

2

3

3

Number Components

1 PMT A

2 Optic holder handle

3 Optic holders

The filters steer progressively shorter wavelengths of light to the next detector in the 
array as indicated by the lines and arrows on the top of the polygon.

Optic holders, filters, and mirrors

Optic holders house filters and mirrors. Your cytometer includes several blank (empty) 
optic holders.          

Caution! To ensure data integrity, do not leave any slots empty in a detector array 
when you are using the associated laser. Always use a blank optic holder.

Caution! Do not remove or change filters. Only BD authorized personnel should 
remove or change the filters.
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Base configurations

Each BD FACSymphony™ A1 flow cytometer has a base cytometer configuration that 
corresponds to the layout of the installed lasers and optics in your cytometer. This base 
configuration is set by your field service engineer.

BD FACSDiva™ cytometer configuration

Before you acquire data using BD FACSDiva™ software, you must specify a cytometer 
configuration. The cytometer configuration defines which filters and mirrors are 
installed at each detector.

BD FACSDiva™ software provides a BD base configuration for your 
BD FACSymphony™ A1 flow cytometer. Select Cytometer > View Configuration to 
create, modify, or delete custom cytometer configurations. (See the Cytometer and 
Acquisition Controls chapter of the BD FACSDiva™ Software Reference Manual for 
details.)

More information
 l About configurations (page 122)

Custom configurations and baselines

Introduction

This topic describes where to find information on how to create a custom 
configuration and define a baseline for a performance check.

Overview

BD Cytometer Setup and Tracking (CS&T) software is used to define the baseline 
performance of your cytometer. A baseline provides a starting point for the tracking of 
cytometer performance. When running a performance check, you compare the results 
to the baseline.

See Optimizing cytometer settings (page 63). Also see the BD Cytometer Setup and 
Tracking Application Guide for information on creating custom configurations and 
defining a baseline.  
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More information
 l Running a performance check (page 67)
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Maintenance
This chapter covers the following topics:
 l Maintenance overview (page 46)
 l Cleaning the fluidics (page 47)
 l Shutting down the cytometer (page 48)
 l Flushing the system (page 49)
 l Replacing the waste tank cap (page 50)
 l Changing the sheath filter (page 52)
 l Changing the Bal seal (page 56)
 l Changing the sample tube O-ring (page 59)
 l Cleaning or replacing the sheath gasket  (page 60)
 l Accessing the red laser detector array (page 61)
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Maintenance overview

Introduction

This topic provides an overview of the BD FACSymphony™ A1 flow cytometer routine 
maintenance and cleaning procedures.

General use guidelines
Caution: Biohazard! Contact with biological specimens and materials can transmit 
potentially fatal disease. 

Follow these guidelines whenever operating or maintaining the cytometer:
 l Wear suitable protective clothing, eyewear, and gloves.
 l Handle all biological specimens and materials in accordance with applicable 

regulations and manufacturer specifications.
 l Dispose of waste using proper precautions and in accordance with local regulations.
 l Never pipette by mouth.

For fluidics maintenance, we recommend the following cleaning solutions: 
 l BD FACSClean™ solution
 l BD Detergent Solution Concentrate
 l 10% bleach solution

Use DI water to dilute bleach to appropriate concentrations. 

Caution! Higher concentrations of bleach and use of other cleaning solutions might 
damage the cytometer.

When to perform maintenance procedures         

Perform maintenance procedures in the following frequencies.

Frequency Maintenance procedure

Daily  l Cleaning the fluidics (page 47)

 l Shutting down the cytometer (page 
48)
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Frequency Maintenance procedure

Scheduled (every two weeks)  l Flushing the system (page 49)

Periodic (frequency depends on how often you run 
the cytometer)

 l Changing the sheath filter (page 52)

 l Changing the Bal seal (page 56)

 l Changing the sample tube O-ring 
(page 59)

 l Cleaning or replacing the sheath 
gasket  (page 60)

Cleaning the fluidics

Introduction

This topic describes how to perform the daily fluidics cleaning.

Overview

Cleaning the fluidics daily prevents the sample injection tube from becoming clogged 
and removes dyes that can remain in the tubing. 

In addition to daily cleaning, follow this procedure immediately after running viscous 
samples or nucleic acid dyes such as Hoechst, DAPI, propidium iodide (PI), acridine 
orange (AO), or thiazole orange (TO).

Procedure

To clean the fluidics:
 1. Press RUN and HIGH on the cytometer fluid control panel. 
 2. Install a tube containing 3 mL of a 10% bleach solution on the SIP with the support 

arm to the side (vacuum on) and let it run for 1 minute.
 3. Move the tube support arm under the tube (vacuum off) and allow the cleaning 

solution to run for 5 minutes with the sample flow rate set to HIGH.
 4. Repeat steps 2 and 3 with a 1.5% dilution of BD Detergent Solution Concentrate.             

Note: The BD Detergent Solution Concentrate must be diluted before use. Mix one 
full 15 mL bottle of BD Detergent Solution Concentrate into 985 mL of DI water to 
make 1 L total.

   47



   BD FACSymphony™ A1 Flow Cytometer User's Guide

Caution: Never mix BD Detergent Solution and bleach because they create 
chlorine gas.

 5. Repeat steps 2 and 3 with DI water.
 6. Press the STANDBY button on the fluidics control panel.
 7. Place a tube containing less than 1 mL of DI water on the SIP.

A tube with less than 1 mL of DI water should remain on the SIP to prevent salt 
deposits from forming in the injection tube. This tube also catches back drips from 
the flow cell.

Caution! Do not leave more than 1 mL of water on the SIP. When the 
instrument is turned off or left in standby mode, a small amount of fluid will drip 
back into the sample tube. If there is too much fluid in the tube, it could overflow 
and affect the cytometer performance.

Shutting down the cytometer

Before you begin

Each time you shut down the cytometer, perform the daily cleaning as described in 
Cleaning the fluidics (page 47).         

Procedure

To shut down the cytometer:
 1. Place a tube of DI water on the SIP.
 2. Turn off the flow cytometer.
 3. Close BD FACSDiva™ software.
 4. Select Start > Shutdown to turn off the computer (if needed).
 5. If your system is connected to the FFSS, shut off the FFSS.

If the cytometer will not be used for a week or longer, perform a system flush and 
leave the fluidics system filled with DI water to prevent saline crystals from clogging 
the fluidics.

More information
 l Cleaning the fluidics (page 47)
 l Flushing the system (page 49)
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Flushing the system

Introduction

This topic describes how to perform an overall fluidics cleaning to remove debris and 
contaminants from the sheath tubing, waste tubing, and flow cell. Perform the system 
flush at least every 2 weeks. The flush should be performed more often when the 
system is first installed or after a major fluidics repair.       

Note: If you are using the BD FACSFlow™ supply system, see the BD FACSFlow™ 
Supply System User’s Guide for instructions on flushing the system.

Cautions
Caution: Biohazard! The cytometer hardware might be contaminated with 
biohazardous material. Use 10% bleach to decontaminate the instrument. 

Procedure

To perform a system flush:
 1. Remove the sheath filter.

 a. Press the quick-disconnects on both sides of the filter assembly.
 b. Remove the filter assembly.
 c. Connect the two fluid lines.

Caution! Do not run detergent, bleach, or ethanol through the sheath filter. 
They can break down the filter paper within the filter body, causing particles 
to escape into the sheath fluid, possibly clogging the flow cell.

 2. Empty the sheath tank and rinse it with DI water.
 3. Fill the sheath tank with at least 1 L of BD FACSClean™.
 4. Empty the waste tank, if needed.
 5. Open the roller clamp by the fluidics interconnect, and drain the fluid into a beaker 

for 5 seconds.
 6. Remove the DI water tube from the SIP.
 7. Prime the instrument twice:

 a. Press the PRIME button on the fluidics control panel. 
 b. When the STANDBY button light is amber, press the PRIME button again.
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 8. Install a tube with 3 mL of BD FACSClean™ on the SIP and put the tube support 
arm underneath the tube.
See Maintenance overview (page 46) for other recommended cleaning solutions.

 9. Press RUN and HIGH on the cytometer fluid control panel. Ensure that the sample 
fine adjust is set to 250. Run for 30 minutes.

 10. Press the STANDBY fluid control button and depressurize the sheath tank by lifting 
the vent valve.

 11. Empty the waste tank to avoid the mixing of bleach and BD Detergent Solution.

Caution: Never mix BD Detergent Solution and bleach because they create 
chlorine gas.

 12. Repeat steps 2 through 11 with 1.5% BD Detergent Solution Concentrate.

Note: The BD Detergent Solution Concentrate must be diluted before use. Mix one 
full 15 mL bottle of BD Detergent Solution Concentrate into 985 mL of DI water to 
make 1 L total.

 13. Leave the system filled with 1.5% dilution of BD® Detergent Solution Concentrate 
overnight to soak (if possible, up to 18 hours) to reduce air adhesion throughout the 
system.  When soaking, the system power should be disconnected and secured. 
Upon completion of the soak period, restore power and continue to the next step 
in this procedure .

 14. Repeat steps 2 through 11 with DI water.
 15. Replace the sheath filter and refill the sheath tank with sheath fluid.
 16. Install a tube with less than 1 mL of DI water onto the SIP.

Replacing the waste tank cap

Introduction

This topic describes how to replace the waste tank cap. Replace the cap once a month. 
       

Biological precautions
Caution: Biohazard! Contact with biological specimens and materials can transmit 
potentially fatal disease.
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To prevent exposure to biohazardous agents:
 l Put the cytometer in standby mode before disconnecting the waste tank to avoid 

leakage of biohazardous waste.
 l The waste tank can become pressurized when the cytometer is running. Always 

disconnect the waste tank from the cytometer before you empty it. Wait at least 
30 seconds for pressure to dissipate before you remove the waste cap or sensor.

 l Expose waste tank contents to bleach (10% of total volume) for 30 minutes before 
disposal.

Procedure

To replace the cap:
 1. Put the cytometer in standby mode.
 2. Disconnect the orange waste line from the waste tank.
 3. Disconnect the alarm sensor line from the alarm sensor socket.

Note: Wait at least 30 seconds for pressure to dissipate.
 4. Remove the waste cap and attached trap from the tank and place on the bench 

label-side up.
 5. Detach the cap from the trap.
 6. Place a new cap on the trap.
 7. Write the date in the white space on the cap label.

338677 Rev A

Waste (A)

 8. Screw the cap assembly onto the waste tank and hand-tighten until it is fully 
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closed.

Caution: Biohazard! To prevent waste tank overpressurization, do not 
overtighten the trap or attached filter cap. Tighten each component only until it 
is hand-tight. Do not use sealants such as Teflon® tape or other adhesives.

 9. Re-attach the alarm sensor line and waste line to the waste tank.

Changing the sheath filter

Introduction

This topic describes how to change the sheath filter. The sheath filter is connected in-
line with the sheath line. It filters the sheath fluid as it comes from the sheath tank. 

When to change the sheath filter

We recommend changing the sheath filter assembly every six months. Increased 
debris appearing in an FSC vs SSC plot can indicate that the sheath filter needs to be 
replaced. See Supplies and consumables (page 141) for ordering information.

When working with the small particle detector, we recommend using a sheath filter 
with a pore size smaller than the particles of interest.

Confirm you have a new sheath filter and                  Teflon® tape before you start the 
procedure.
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Sheath filter assembly

10

9

2

4

5

8

6

7

1

3

Number Components Number Components

1 Sheath line to cytometer 6 Filter base

2 Quick-disconnect 7 Quick-disconnect

3 Post-filtered sheath line 8 Sheath fluid line from tank

4 Hose clamp 9 Vent fitting

5 Sheath filter 10 Vent line

Removing the old filter

To remove the old filter:
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 1. Place the cytometer in standby mode.
 2. Remove the sheath filter assembly by pressing the quick-disconnect on both sides 

of the filter assembly.

 3. To install a small particle filter, set the standard sheath filter assembly aside and 
move to Attaching the new small particle filter (page 55). To replace the standard 
sheath filter, continue the steps in this section, then move to Attaching the new 
standard filter (page 54).

 4. Over a sink or beaker:
 l Remove the vent line from the filter and save it to use again. 
 l Remove the filter base and save it to use again.
 l Remove the post-filtered sheath line by using a screwdriver to gently pop the 

hose camp off the filter and save it to use again.
 5. Discard the used filter in an appropriate receptacle.

Attaching the new standard filter

To attach the new standard filter:
 1. Connect the vent line to the new sheath filter assembly. Twist to attach.
 2. Wrap Teflon® tape around the filter threads, then connect the filter to the filter 

base.
 3. Install the hose clamp onto the post-filtered sheath line then attach it to the filter.
 4. Connect the sheath line (coming from the sheath tank) to the filter assembly via 

the quick-disconnect.
 5. Connect sheath line (going into the cytometer) to the post-filtered sheath line via 

quick-disconnect.             

Note: Ensure that the new filter is installed with the directional flow arrow pointing 
toward the sheath line that goes to the cytometer.

 6. Confirm that the cytometer is on.
 7. Direct the vent line into a receptacle and press the small button at the end of the 

vent fitting against the side of the receptacle until a steady stream of fluid 
empties from the filter.

 8. Tilt the filter and verify that no trapped air remains in the filter.
 9. Repeat steps 7 and 8 as necessary to remove all trapped air.
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 10. If necessary, to remove trapped air in the filter and sheath line, dispense fluid from 
sheath line via the roller clamp that is connected to the sheath line past  the sheath 
filter assembly. See Removing air bubbles (page 34).

Attaching the new small particle filter

Small particle filter assembly

X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X
X

X
X
X
X
X
X
X
X
X
X
X
X
X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X
X
X
X
X
X
X
X
X
X

X
X

X
X

X
X

X
X

X
X

X
  

  
  

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X

X
X
X
X
X
X
X
X
X
X
X
X
X
X

F
L
O
W3

3
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1
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2

5

6

5

Number Components Number Components

1 Quick-disconnect 4 Nut

2 Bleeder valve 5 Filter base

3 Plug 6 0.04 µm filter

To attach the new small particle filter:
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 1. Wrap both ends of the filter threads with Teflon® tape.

 2. Connect a filter base to both ends of the filter.
 3. Wrap Teflon® tape around the threads of two male quick-disconnect fittings.

 4. Connect the male quick-disconnect fittings to the filter base on both ends of the 
filter.

 5. Connect the filter to the sheath lines via the quick-disconnects at both ends of the 
filter.             

Note: Ensure that the filter is installed with the directional flow arrow pointing 
towards the sheath line that goes to the cytometer.

 6. Ensure the cytometer is on.
 7. Direct the bleeder valve closest to the sheath line that goes to the cytometer into 

a receptacle. Open the valve by unscrewing the nut until fluid comes out. Leave 
the valve open until no bubbles are seen.

 8. Tilt the filter and verify that no trapped air remains in the filter.
 9. Repeat steps 7 and 8 as necessary to remove all trapped air.

 10. Close the valve.             

Note: Do not close the bleeder valve too tightly. If the valve is closed too tightly, 
the plug will pop out and the valve will leak. To fix a popped plug, loosen the valve 
nut and push the plug back towards the filter until it pops back into the nut. Then 
close the valve.

 11. Remove trapped air in the sheath lines by opening the roller clamp at the fluidics 
interconnect. Collect the fluid in a waste container. Close the roller clamp.

Note: The roller clamp can be found close to the fluidics ports of the cytometer.

 12. If installing a new small particle filter, flush at least 500 mL of fluid through the 
filter via the roller clamp at the fluidics interconnect.

Changing the Bal seal

Introduction

This topic describes how to replace the Bal seal. 

The sample injection tube Bal seal is a ring that forms a seal with the sample tube and 
ensures proper tube pressurization. 
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When to change the Bal seal

Over time, the Bal seal becomes worn or cracked and requires replacement. 
Replacement is necessary if a proper seal is not formed when a sample tube is installed 
on the SIP. Indications that a proper seal has not formed include:
 l The tube will not stay on the SIP without the tube support arm.
 l When the tube is installed and RUN is pressed on the cytometer, the RUN button is 

orange (not green).

Caution
Caution: Biohazard! Cytometer hardware might be contaminated with 
biohazardous material. Wear suitable protective clothing, eyewear, and gloves 
whenever cleaning the cytometer or replacing parts.

Procedure

To replace the Bal seal:
 1. Remove the outer sleeve from the sample injection tube by turning the retainer 

counter-clockwise. Slide the outer sleeve down and off of the sample injection 
tube.
Work carefully. The outer sleeve can fall off as you loosen the retainer. See the 
following illustration.

4

3

2

1
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Number Components

1 Bal seal

2 Retainer

3 Outer sleeve

4 Sample injection tube (SIT)

 2. Remove the Bal seal by gripping it between your thumb and index finger and 
pulling down. See the following illustration.
 

 3. Install the new Bal seal spring-side up.
Ensure that the sample tube O-ring is still in place inside the retainer. 

 4. Re-install the retainer and outer sleeve over the sample injection tube. Push the 
outer sleeve all the way up into the sample injection port and then screw the 
retainer into place and tighten to finger tight. This will seat the Bal seal.

 5. Install a sample tube on the SIP to ensure that the outer sleeve has been properly 
installed. 
If the sleeve hits the bottom of the tube, loosen the retainer slightly and push the 
sleeve up as far as it will go. Tighten the retainer.
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Changing the sample tube O-ring

Introduction

This topic describes how to replace the sample tube O-ring.

The sample tube O-ring, located within the retainer, forms a seal that allows the 
droplet containment vacuum to function properly. 

When to replace the O-ring

Replace the O-ring when droplets form at the end of the sample injection tube while 
the vacuum is operating.

Caution
Caution: Biohazard! Cytometer hardware might be contaminated with 
biohazardous material. Wear suitable protective clothing, eyewear, and gloves 
whenever cleaning the cytometer or replacing parts.

Procedure

To change the O-ring:
 1. Remove the outer sleeve from the sample injection tube by turning the retainer 

counter-clockwise.
 2. Slide the outer sleeve from the retainer. See the following illustration.

2

1
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Number Components

1 O-ring

2 Retainer

 3. Invert the outer droplet sleeve and allow the O-ring to fall onto the benchtop. 
If the O-ring does not fall out initially, hold the O-ring with your free hand and slide 
the outer sleeve to remove the O-ring.

 4. Place the new O-ring into the retainer. Make sure the O-ring is seated properly in 
the bottom of the retainer.

 5. Replace the outer sleeve in the retainer.
 6. Re-install the retainer and the outer sleeve.
 7. Install a sample tube on the SIP to ensure that the outer sleeve has been properly 

installed. 
If the sleeve hits the bottom of the tube, loosen the retainer slightly and push the 
sleeve up as far as it will go. Tighten the retainer.

Cleaning or replacing the sheath gasket 

Introduction

This topic describes how to clean or replace the gasket of the sheath tank lid.         

When to change the sheath gasket

We recommend cleaning the sheath gasket when needed.

Procedure

To clean or replace the gasket:
 1. Put the cytometer in standby mode.
 2. Depressurize the sheath container by pulling up on the vent valve.
 3. Remove the lid from the sheath tank. 
 4. Remove the black gasket from the lid. 
 5. Rinse it with water to clean the gasket. 
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 6. Place the clean gasket or the new gasket on the lid and make sure the gasket is 
seated properly on the lid. 

Accessing the red laser detector array
This topic describes how to access the red laser detector array for the purpose of 
checking or changing the optical filters. The access panel is located on the right-hand 
side of the cytometer.

To remove the access panel:
 1. Locate the red laser detector array access panel on the side of the cytometer, see 

Cytometer overview (page 15). 
 2. Remove the thumb screws and set them aside.
 3. Place a small stiff object such as a thin screwdriver in one of the thumbscrew holes.
 4. Tilt the screwdriver handle close to the cytometer and pull outwards to pop the 

panel off the cytometer.

To replace the access panel:
 1. Position the panel over the the red laser detector array. 
 2. Push evenly on both sides to pop the panel back onto the cytometer.
 3. Screw in the thumbscrews.    
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Optimizing cytometer settings
This chapter covers the following topics:
 l Cytometer settings workflow (page 64)
 l Verifying the configuration and user preferences (page 65)
 l Running a performance check (page 67)
 l Setting up an experiment (page 70)
 l Creating application settings (page 75)
 l Recording compensation controls (page 77)
 l Calculating compensation (page 80)
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Cytometer settings workflow

Introduction

This topic describes how to optimize cytometer settings. The optimization is 
performed using the Cytometer Setup and Tracking, Application Settings, and 
Compensation Setup features of BD FACSDiva™ software. 

When to optimize settings

Before you record data for a sample, optimize the cytometer settings for the sample 
type and fluorochromes used.          

Manual compensation

Compensation setup automatically calculates compensation settings. If you choose to 
perform compensation manually, not all of the following instructions apply. For 
detailed instructions, see the BD FACSDiva™ Software Reference Manual.

First-time users

If you are performing the procedures in this workflow for the first time, you should be 
familiar with BD FACSDiva™ software concepts: workspace components, cytometer 
and acquisition controls, and tools for data analysis.

For additional details, see the BD FACSDiva Software Reference Manual.

Before you begin

Start the BD FACSymphony™ A1 flow cytometer and perform the setup and QC 
procedures. See Cytometer setup (page 29).

Workflow for optimizing settings

Cytometer optimization consists of the following steps.

Step Description

1 Verifying the configuration and user preferences (page 65)
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Step Description

2 Running a performance check (page 67)

3 Setting up an experiment (page 70)

4 Creating application settings (page 75)

5 Recording compensation controls (page 77)

6 Calculating compensation (page 80)

Note: Application settings are optional and do not have to be saved for the 
experiments. However, they are useful for optimizing cytometer settings.

About the examples

The examples in this chapter use a 4-color bead sample with the following 
fluorochromes:         
 l FITC
 l PE
 l PerCP-Cy5.5
 l APC

If you follow this workflow with a different bead sample (or another sample type), your 
software views, data plots, and statistics might differ from the example. Additionally, 
you might need to modify some of the instructions in the procedure.

The information shown in italics is for example only. You can substitute your own 
names for folders and experiments.

Verifying the configuration and user 
preferences

Introduction

This topic describes how to verify the cytometer configuration and user preferences 
before you create an experiment.

Caution! To obtain accurate data results, the current cytometer configuration must 
reflect your BD FACSymphony™ A1 flow cytometer optics. 
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Procedure

To verify the configuration and preferences before you create an experiment:
 1. Select Cytometer > View Configurations and verify the current configuration. 

Your cytometer might include only the base configuration when your cytometer is 
installed. You can create additional configurations later as needed. 
In this example, the cytometer configuration must include the following 
parameters: FITC, PE, PerCP-Cy5.5, and APC.

 2. If you need to select a configuration other than the current configuration:
 a. In the Configurations tab, select a configuration. 
 b. Click Set Configuration.
 c. Click OK. 
 d. Verify that the configuration you just set matches your BD FACSymphony™ A1 

flow cytometer optics.
 3. Click OK to close the Cytometer Configuration window.
 4. Select File > Exit to close CS&T.
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 5. Select Edit > User Preferences. 
 6. Click the General tab and select the Load data after recording checkbox.

See the BD FACSDiva™ Software Reference Manual for more information about 
cytometer configurations and user preferences.

More information
 l Setting up an experiment (page 70)

Running a performance check

Introduction

This topic describes how to run a performance check as part of quality control.

Overview

The CS&T application is designed to monitor performance on a daily basis and to 
optimize laser delay. 

Running a performance check on a regular basis provides a standard for monitoring 
changes in performance due to degradation of laser power, aging of PMTs, and other 
potential cytometer service issues. Performance results are also affected by fluidics 
performance. We strongly recommend following the fluidics maintenance procedures 
as described in Cleaning the fluidics (page 47).

Considerations

Some BP filters might not be normalized to CS&T settings. In this case, CS&T will 
generate Qr and Br numbers that are not comparable from instrument to instrument. 
They are however, still trackable on one cytometer. Part of the process for optimizing 
cytometer settings includes verifying PMT voltages set by CS&T for all parameters. 
Carefully examine any channel with a non-CS&T normalized filter. If the baseline 
settings are not appropriate for your applications, adjust the PMT voltage as necessary 
and use the Application Settings to maintain Target Values.

Before you begin

Define the performance baseline for any configuration before running a performance 
check. See Custom configurations and baselines (page 42).
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Procedure

To run a performance check:
 1. Select Cytometer > CST.
 2. Verify that the bead lot information under Setup Beads matches the Cytometer 

Setup and Tracking bead lot.

 3. Verify that the cytometer configuration is correct for your experiment.

If the cytometer is not set to the correct configuration:
 a. Click Select Configuration in the Setup Control window.
 b. Select the correct configuration from the list.
 c. Click Set Configuration and then click OK.

 4. Verify that the current configuration has a valid baseline defined.
If not, see the BD Cytometer Setup and Tracking Application Guide for more 
information on defining a baseline.

 5. Prepare the CS&T beads according to the technical data sheet provided with the 
beads or available on the BD Biosciences website (bdbiosciences.com).

 6. Install the bead tube onto the SIP.
 7. In the Setup Control window, select Check Performance from the Characterize 

menu.
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 8. Click Run.
 9. Ensure that Fine Adjust is set to 250, press RUN, and LOW.

Plots appear under the Setup tab and the performance check is run. The 
performance check takes approximately 5 minutes to complete.

 10. Once the performance check is complete, click View Report.
 11. Verify that the cytometer performance passed.

In the Setup tab, the cytometer performance results should have a green checkbox 
displayed and the word Passed next to it.

If any parameters did not pass, see the BD Cytometer Setup and Tracking 
Application Guide for troubleshooting information.

 12. Select File > Exit to close the CS&T window and return to the BD FACSDiva™ 
interface.
The CST Mismatch dialog opens.
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Click the Details button to verify which cytometer settings will be updated.
 13. Click Use CST Settings.

By selecting Use CST Settings, the laser delay, area scaling, and other cytometer 
settings will be updated to the latest settings from the performance check.

Setting up an experiment

Introduction

This topic describes how to create an experiment in a new folder, specify the 
parameters of the experiment, and add compensation tubes.

Creating an experiment

To create an experiment:
 1. Click the buttons on the Workspace toolbar to display the following windows as 

needed:
 l Browser 
 l Cytometer 
 l Inspector 
 l Worksheet 
 l Acquisition Dashboard 
When you add elements or make selections in the Browser, the Inspector displays 
details, properties, and options that correspond to your selection.

 2. Click the New Folder button on the Browser toolbar to add a new folder. 
 3. Click the folder and rename it MyFolder.
 4. Click MyFolder, then click the New Experiment button on the Browser toolbar. 
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 a. Click the new experiment in the Browser and rename it MyExperiment.
 5. Select MyExperiment in the Browser. 

The Inspector displays details for the experiment. 

Specifying parameters

To specify the parameters for the new experiment:
 1. Select Cytometer Settings for the experiment in the Browser.

Cytometer settings appear in the Inspector.
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 2. Make sure the parameters you need appear on the Parameters tab in the 
Inspector.
If more than one parameter is available for a particular detector, you might have 
to select the one you need from a menu. For example, you can set Detector D for 
the blue laser as FITC or BB515.

 a. Click the Parameter name to display the available fluorochromes in the 
Parameters list. 
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 b. Select the specific parameter from the menu. Your selection appears as the 
selected parameter.
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 c. For this example, select FITC from the menu.
 3. Delete any unnecessary parameters.

 a. Click the selection button (to the left of the parameter name) to select the 
parameter.

74   



Chapter 5  Optimizing cytometer settings

 b. Click Delete. 
The parameter is deleted.

Creating application settings

Introduction

This topic describes how to create application settings.

About application settings

Application settings are associated with a cytometer configuration and include the 
parameters for the application, area scaling values, PMT voltages, and threshold 
values, but not compensation. Each time a performance check is run for a 
configuration, the application settings associated with that configuration are updated 
to the latest run.

Using application settings provides a consistent and reproducible way to reuse 
cytometer settings for commonly used applications.
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Before you begin

Perform the cytometer setup procedure and run a performance check for the 
configuration that will be used for the application.

Procedure

To create application settings:
 1. In the open experiment, right-click Cytometer Settings in the Browser, then select 

Application Settings > Create Worksheet.
A second global worksheet is added with the plots created according to the 
selections in the Parameters tab. 

 2. Load the unstained control tube onto the cytometer.
 3. In the Cytometer window, optimize the PMT voltages for the application.

 l Optimize the FSC and SSC voltages to place the population of interest on scale.
 l Optimize the FSC threshold value to eliminate debris without interfering with 

the population of interest.
 l If needed, increase the fluorescence PMT voltages to place the negative 

population appropriately for your sample type.
 4. Unload the unstained control tube from the cytometer.
 5. Load the multicolor sample onto the cytometer or load single-color control tubes 

and verify each fluorochrome signal separately.
 6. Verify that the positive populations are on scale.

If a positive population is off scale, lower the PMT voltage for that parameter until 
the positive population can be seen entirely on scale.

 7. Unload the multicolor sample.
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 8. Place a tube containing less than 1 mL DI water on the SIP and put the cytometer 
on standby.

 9. (Optional) Save the application settings by right-clicking Cytometer settings in the 
Browser, then selecting Application Settings > Save.

 10. In the Save Application Settings dialog, enter a descriptive name for the 
application settings.

 11. Click OK.
The application settings are saved to the catalog.

Recording compensation controls

Introduction

This topic describes how to create and record compensation controls using the 
Compensation Setup feature of BD FACSDiva™ software and an experiment with 
optimized settings.         

Creating compensation tubes

To create compensation control tubes:
 1. Select Experiment > Compensation Setup > Create Compensation Controls.

The Create Compensation Controls dialog opens.
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For this bead example, you do not need to provide non-generic tube labels.

2. Click OK.

Compensation control tubes are added to the experiment. Worksheets containing 
appropriate plots and gates are added for each compensation tube.

Recording compensation settings

To record compensation settings:         
 1. Press RUN and HIGH on the cytometer fluid control panel.
 2. Install the unstained control tube onto the SIP. 
 3. Expand the Compensation Controls specimen in the Browser.
 4. Set the current tube pointer to the unstained control tube (it becomes green), then 

click Acquire Data in the Acquisition Dashboard.
 5. Verify that the population of interest is displayed appropriately on the FSC vs SSC 

plot and adjust voltages if necessary.
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Since the application settings have been optimized for your sample, the cytometer 
settings should not require adjustment other than the changing of FSC and SSC 
voltages to place the beads on scale.

 6. Adjust the P1 gate to surround only the singlets.
 7. Right-click the P1 gate and select Apply to All Compensation Controls. 

The P1 gate on each stained control worksheet is updated with your changes.
 8. Click Record Data.
 9. When recording is finished, remove the unstained control tube from the cytometer.

 10. Click Next Tube.

Caution! Do not change the PMT voltages after the first compensation control 
has been recorded. In order to calculate compensation, all controls must be 
recorded with the same PMT voltage settings. If you need to adjust the PMT 
voltage for a subsequent compensation control, you must record all 
compensation controls again.

 11. Install the next tube onto the cytometer and repeat steps 8 through 10 until data 
for all stained control tubes has been recorded.

 12. Double-click the first stained control tube to display the corresponding worksheet.
 13. Verify that the snap-to interval gate encompasses the positive population.
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 14. Repeat steps 12 and 13 for the remaining compensation tubes.

Next step

After you have recorded data for each single-stained control, calculate compensation 
as described in Calculating compensation (page 80).

Calculating compensation

Introduction

This topic describes how to calculate compensation.

Before you begin

Before you can calculate compensation, you need to record the data for each single-
stained control.

Procedure

To calculate compensation:
 1. Select Experiment > Compensation Setup > Calculate Compensation.

Note: If the calculation is successful, a dialog prompts you to enter a name for the 
compensation setup. The default name is year/month/day/time.

 2. Enter a setup name and click Link & Save.
The compensation is linked to the cytometer settings and saved to the catalog.
To help track compensation setups, include the experiment name, date, or both in 
the setup name.
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The compensation setup is linked to the MyExperiment cytometer settings, and 
subsequent acquisitions in MyExperiment are performed with the new 
compensation settings.

We recommend that you always visually and statistically inspect automatically 
calculated spectral overlap values. The medians of the positive controls should be 
aligned with the medians of the negative controls.

More information
 l Recording compensation controls (page 77)
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Recording and analyzing data
This chapter covers the following topics:
 l Data recording and analysis workflow (page 84)
 l Preparing the workspace (page 85)
 l Recording data (page 86)
 l Analyzing data (page 88)
 l Reusing an analysis (page 93)
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Data recording and analysis workflow

Introduction

This topic outlines the basic acquisition and analysis tasks using BD FACSDiva™ 
software.

About the examples

The examples in this chapter are from two 4-color bead samples with the following 
fluorochromes:         
 l FITC
 l PE
 l PerCP-Cy5.5
 l APC

If you use a different sample type or if you have skipped the optimization steps in 
Optimizing cytometer settings (page 63), your software window content, names of 
folders and experiments, and your data plots and statistics might differ from those 
shown here. You might also need to modify some of the instructions in the procedure.

For additional details on completing some of the following steps, see the 
BD FACSDiva™ Software Reference Manual.

Workflow for recording and analyzing data

Recording and analyzing data consists of the following steps.

Step Description

1 Preparing the workspace (page 85)

2 Recording data (page 86)

3 Analyzing data (page 88)

4 Reusing an analysis (page 93)
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Preparing the workspace

Introduction

This topic describes how to prepare the workspace and apply application settings to 
your experiment before recording data.

Procedure

To prepare the workspace:
 1. Using the Browser toolbar, create a new specimen in MyExperiment and rename it 

FourColorBeads.
 2. Create two tubes for the FourColorBeads specimen. Rename the tubes Beads_001 

and Beads_002.
 3. Expand the Global Worksheets folder in MyExperiment to access the default 

global worksheet, and rename the worksheet MyData.
 4. On the MyData worksheet, create the following plots for previewing the data:

 l FSC vs SSC
 l FITC vs PE
 l FITC vs PerCP-Cy5.5
 l FITC vs APC

Applying saved application settings to a new experiment

When applications settings are applied to an experiment, the cytometer settings are 
updated with the parameters included in the application settings, optimized PMT 
voltages, threshold settings, area scaling factors, and window extension values.         

To apply saved application settings to your experiment:
 1. Right-click the experiment-level Cytometer Settings and select Application 

Settings > Apply.
 2. In the Application Settings catalog, select the application settings file you saved 

previously and click Apply.
If the parameters are not the same, a mismatch dialog opens. 
 l Click Overwrite to update all settings.
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 l Click Apply to change only the common parameters.
For more information, see the BD FACSDiva™ Software Reference Manual.

The cytometer settings are renamed application settings and the cytometer settings 
icon in the Browser changes.

More information
 l Creating application settings (page 75)
 l Recording data (page 86)

Recording data

Introduction

This topic provides an example of how to preview and record data for multiple 
samples.

Before you begin

Prepare the sample tubes.

Note: If you need to run samples at an event rate greater than 10,000 events/second, 
consider changing your Window extension. See the BD FACSDiva™ Software Reference 
Manual for more information.

Recording data

To record data:
 1. Press RUN and HIGH on the cytometer fluid control panel.
 2. Install the first sample tube onto the SIP.
 3. Set the current tube pointer to Beads_001. 
 4. Click Acquire Data in the Acquisition Dashboard to begin acquisition. 
 5. While data is being acquired:

 a. Draw a gate around the singlets on the FSC vs SSC plot.
 b. Rename the P1 gate to Singlets.
 c. Use the Inspector to set the other plots to show only the singlet population by 
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selecting the Singlets checkbox.

 6. Click Record Data.
 7. When event recording has completed, remove the first tube from the cytometer. 

The MyData worksheet plots should look like the following.

 8. Install the second sample tube onto the SIP.
 9. Set the current tube pointer to Beads_002.

 10. Click Acquire Data to begin acquisition.
 11. Before recording, preview the data on the MyData worksheet to verify that all 

expected populations are visible and the data is similar to the previous sample.
 12. Click Record Data.
 13. When event recording has completed, remove the second tube from the 

cytometer.
 14. If you are recording more than two tubes, repeat steps 8 through 13 for the 

remaining tubes.
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 15. Print the experiment-level cytometer settings by right-clicking the Cytometer 
Settings icon in the Browser and selecting Print.

 16. Install a tube with less than 1 mL of DI water onto the SIP. 
 17. Place the cytometer in standby mode.

Analyzing data

Introduction

This topic describes how to analyze recorded tubes by creating plots, gates, a 
population hierarchy, and statistics views on a new global worksheet. 

Analyzing data

To analyze data:
 1. Use the Browser toolbar to create a new global worksheet. Rename it 

MyDataAnalysis.
 2. Create the following plots on the MyDataAnalysis worksheet:

 l FSC vs SSC
 l FITC vs PE
 l FITC vs PerCP-Cy5.5
 l FITC vs APC

 3. Create a population hierarchy and a statistics view, and set them below the plots 
on the worksheet.
 l Right-click any plot and select Show Population Hierarchy. 
 l Right-click any plot and select Create Statistics View. 

 4. Set the current tube pointer to Beads_001.
 5. Draw a gate around the singlets on the FSC vs SSC plot. 
 6. Use the population hierarchy to rename the population Singlets.
 7. Select all plots except the FSC vs SSC plot, and use the Plot tab in the Inspector to 

specify to show only the singlet population.
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 8. Select all plots, and click the Title tab in the Inspector. 
 9. Select the Tube and Populations checkboxes to display their names in plot titles.

 10. On all fluorescence plots:
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 l Make all plots biexponential. Select all fluorescence plots and select the X Axis 
and Y Axis checkboxes in the Plot tab of the Inspector.

 l In the FITC vs PE plot, draw a gate around the FITC-positive population. Name 
the population FITC positive in the population hierarchy.

 l In the FITC vs PE plot, draw a gate around the PE-positive population. Name the 
population PE positive in the population hierarchy.

 l In the FITC vs PerCP-Cy5.5 plot, draw a gate around the PerCP-Cy5.5-positive 
population. Name the population PerCP-Cy5.5 positive in the population 
hierarchy.

 l In the FITC vs APC plot, draw a gate around the APC-positive population. Name 
the population APC positive in the population hierarchy.

 11. Format the statistics view.
 a. Right-click the statistics view and select Edit Statistics View.
 b. Click the Header tab and select the Specimen Name and Tube Name 

checkboxes.
 c. Click the Populations tab and select all populations except All Events. Clear the

 %Parent, %Total, and #Events checkboxes.
 d. Click the Statistics tab and select the mean for each of the fluorescence 

parameters.

90   



Chapter 6  Recording and analyzing data

 e. Click OK.
 12. Print the analysis.

Your global worksheet analysis objects should look like the following.
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Reusing an analysis

Introduction

This topic describes how to use a global worksheets to apply the same analysis to a 
series of recorded tubes. Once you define an analysis for a tube, you can use it to 
analyze the remaining tubes in the experiment. After viewing the data, print the 
analysis or save it to a normal worksheet.

Reusing an analysis

To reuse the analysis:
 1. Set the current tube pointer to the Beads_002 tube.
 2. View the Beads_002 data on your analysis worksheet. Adjust the gates as needed.

Adjustments apply to subsequent tubes viewed on the worksheet. To avoid altering 
a global worksheet, save an analysis to a normal worksheet, then make 
adjustments on the normal worksheet.

 3. Print the analysis.

Saving the analysis

When you perform analysis with a global worksheet, the analysis does not save with 
the tube.

If you define your analysis on a global worksheet before recording data, you can 
specify to automatically save the analysis after recording data. You set this option in 
User Preferences.

To save a copy of the analysis with a tube:
 1. Expand the MyDataAnalysis global worksheet icon in the Browser.
 2. Right-click its analysis and select Copy.

 3. Click the Worksheets View button on the Worksheet toolbar to switch to the 
normal worksheet view.
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 4. Select Worksheet > New Worksheet to create a new normal worksheet.
 5. Right-click the Beads_001 tube icon in the Browser, and select Paste.

The analysis objects from the MyDataAnalysis global worksheet are copied to the 
Beads_001_Analysis normal worksheet. Double-click the Beads_001 tube in the 
Browser to view the analysis.

Applying an analysis to normal worksheets

You can apply the global worksheet analysis to multiple tubes (on a single normal 
worksheet) by selecting multiple tubes before pasting the analysis. Ensure that you 
collapse all tube elements in the Browser before you paste them to multiple tubes.

More information
 l Analyzing data (page 88)
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Technical overview
This chapter provides a technical overview of the following topics:
 l About fluidics (page 96)
 l About optics (page 97)
 l About electronics (page 104)
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About fluidics

Introduction

This topic describes the BD FACSymphony™ A1 flow cytometer fluidics system.

Pressure-driven fluidics system

The fluidics system in the BD FACSymphony™ A1 flow cytometer operates at a 
pressure of 5.5 psi. After passing through the sheath filter, sheath fluid is introduced 
into the lower chamber of the quartz flow cell.

Hydrodynamic focusing

The sample to be analyzed arrives in a separate pressurized stream. When a sample 
tube is placed on the SIP, the sample is forced up and injected into the lower chamber 
of the flow cell by a slight overpressure relative to the sheath fluid. The conical shape 
of the lower chamber creates a laminar sheath flow that carries the sample core 
upward through the center of the flow cell, where the particles to be measured are 
intercepted by the laser beam. This process is known as hydrodynamic focusing.

The objective in flow cytometric analysis is to have at most one cell or particle moving 
through a laser beam at a given time. The difference in pressure between the sample 
stream and sheath fluid stream can be used to vary the diameter of the sample core. 
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Changing the sample flow rate changes the sample pressure thereby changing the 
core diameter. The flow rate should be set according to the type of application you are 
running.
 l A higher flow rate is generally used for qualitative measurements such as 

immunophenotyping. The data is less resolved, but is acquired more quickly.
 l A lower flow rate is generally used in applications where greater resolution and 

quantitative measurements are critical, such as DNA analysis.

Proper operation of fluidic components is critical for particles to intercept the laser 
beam properly. Always ensure that the fluidics system is free of air bubbles and debris, 
and is properly pressurized.

About optics

Introduction

This topic describes the optics system and provides information about: 
 l Light scatter (page 97)
 l Fluorescence (page 98)
 l Optical filter theory (page 98)
 l Compensation theory (page 101)

Optics system

The optics system consists of lasers, optical filters, and detectors. Lasers illuminate the 
cells or particles in the sample and optical filters direct the resulting light scatter and 
fluorescence signals to the appropriate detectors.

Light scatter

When a cell or particle passes through a focused laser beam, laser light is scattered in 
all directions. Light that scatters axial to the laser beam is called forward scatter (FSC) 
and light that scatters perpendicular to the laser beam is called side scatter (SSC). 

FSC and SSC are related to certain physical properties of cells.
 l FSC Indicates relative differences in the size of the cells or particles. Larger cells 

scatter more light and therefore they are higher in FSC.
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 l SSC Indicates relative differences in the internal complexity or granularity of the 
cells or particles. More granular cells deflect more light than less granular cells, and 
therefore are higher in SSC.

Fluorescence

When cells or particles stained with fluorochrome-conjugated antibodies or other dyes 
pass through a laser beam, the dyes can absorb photons (energy) and be promoted to 
an excited electronic state. In returning to their ground state, the dyes release energy, 
most of which is emitted as light. This light emission is known as fluorescence.

Fluorescence is always a longer wavelength (lower-energy photon) than the excitation 
wavelength. The difference between the excitation wavelength and the emission 
wavelength is known as the Stokes shift. Some fluorescent compounds such as PerCP 
exhibit a large Stokes shift, absorbing blue light (488 nm) and emitting red light 
(675 nm), while other fluorochromes such as FITC have a smaller Stokes shift, 
absorbing blue light (488 nm) and emitting green light (530 nm).

Actual emission intensity will depend on excitation wavelength. See Fluorescence 
spectra (page 120) for more information on excitation and emission of fluorochromes. 
An interactive spectrum viewer is also available at bdbiosciences.com.

Optical filter theory

Optical filters modify the spectral distribution of light scatter and fluorescence 
directed to the detectors. When photons encounter an optical filter, they are either 
transmitted, absorbed, or reflected.

Even though an optical filter is rated at its 50% transmission point, the filter passes 
(lets through) a minimal amount of light outside of this indicated rating.

The slope of an optical filter transmission curve indicates filter performance. A 
relatively steep slope indicates a high-performance, high-quality optical filter that 
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provides deep attenuation of out-of-band wavelengths. A less steep slope indicates 
that more light outside the rated bandwidth is being transmitted.

Types of optical filters

There are four types of filters.
 l Longpass (LP) filters Transmit wavelengths at or longer than the specified value.
 l Shortpass (SP) filters           Transmit wavelengths at or shorter than the specified value. 

This type of filter is not recommended.          
 l Bandpass (BP) filters           Pass a narrow spectral band of light by combining the 

characteristics of shortpass filters, longpass filters, and absorbing layers.           
 l Notch filters           Pass all frequencies except those in a stop band centered on a center 

frequency. They are the opposite of bandpass filters.           

The BD FACSymphony™ A1 uses LP filters and BP filters.

Longpass (LP) filters 

LP filters pass wavelengths longer than the filter rating. For example, a 500-LP filter 
permits wavelengths 500 nm or longer to pass through it and either absorbs or reflects 
wavelengths shorter than 500 nm.

Shortpass (SP) filters

An SP filter has the opposite properties of an LP filter. An SP filter passes light with a 
shorter wavelength than the filter rating. For example, a 500-SP filter passes 
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wavelengths of 500 nm or shorter, and reflects or absorbs wavelengths longer than 
500 nm.

Bandpass (BP) filters 

A BP filter transmits a relatively narrow range or band of light. BP filters are typically 
designated by two numbers. The first number indicates the center wavelength and the 
second refers to the width of the band of light that is passed. For example, a 500/50-
BP filter transmits light that is centered at 500 nm and has a total bandwidth of 
50 nm. Therefore, this filter transmits light between 475 and 525 nm.

The performance of an optical BP filter depends on the optical transmission. Sample 
transmission curves are shown in the following figure. A filter with a narrower (steeper) 
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transmission curve generally yields higher performance. The transmission 
specifications depend on the construction of the filter.

Dichroic mirrors

Dichroic filters that are used to direct different color light signals to different 
detectors are called dichroic mirrors.

Although some of the properties of LP and SP filters are similar to dichroic mirrors (for 
example, allowing a specific wavelength range to pass), filters and mirrors cannot be 
used interchangeably, especially if used as dichroic mirrors. A dichroic mirror must have 
a surface coating that reflects certain wavelengths, but many LP or SP filters are 
absorbance filters that do not have any specific reflective characteristics. Also, optical 
filters and dichroic mirrors are rated at a specific angle of incidence. When used in 
front of the fluorescence detectors, they are perpendicular to the incident light, and 
when used as a dichroic mirror, they are placed at an angle relative to the light source. 
Their optical properties are therefore designed for that angle of incidence.

Compensation theory

Fluorochromes emit light over a range of wavelengths. Optical filters are used to limit 
the range of frequencies measured by a given detector. However, when two or more 
fluorochromes are used, the overlap in wavelength ranges often makes it impossible 
for optical filters to isolate light from a given fluorochrome. As a result, light emitted 
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from one fluorochrome appears in a detector intended for another. This is referred to 
as spillover. Spillover can be corrected mathematically by using a method called 
compensation.         

In the following example, FITC emission appears primarily in the FITC detector, but 
some of its fluorescence spills over into the PE detector. The spillover must be 
corrected or compensated for. Alternatively, the spillover can be minimized by discrete 
excitation of fluorochromes. In the following example, excitation with a yellow-green 
configuration will help minimize spillover.

This spillover can be seen in a dot plot of FITC vs PE. The FITC spillover in the PE 
detector must be corrected as demonstrated in the two figures that follow.

Using the Compensation tab of the Cytometer window in BD FACSDiva™ software, 
you can adjust the PE-%FITC spectral overlap value. Compensation is optimal when 
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the positive and negative FITC populations have the same medians in the PE 
parameter statistics.

The following image shows the FITC spillover optimally compensated out of the PE 
parameter.

Once fluorescence compensation has been set for any sample, the compensation 
setting remains valid for a subsequent dim or bright sample (provided the signal is not 
saturated), because compensation subtracts a percentage of the fluorescence 
intensity. The following figure illustrates this principle. Although the signals differ in 
intensity, the percentage of the FITC spillover into the PE detector remains constant.

   103



   BD FACSymphony™ A1 Flow Cytometer User's Guide

About electronics

Introduction

This topic describes the electronics in the BD FACSymphony™ A1 flow cytometer.

Pulse

As cells or other particles pass through a focused laser beam, they scatter the laser 
light and can emit fluorescence. Because the laser beam is focused on a small spot 
and particles move rapidly through the flow cell, the scatter or fluorescence emission 
signal has a very brief duration—only a few microseconds. This brief flash of light is 
converted into an electrical signal by the detectors. The electrical signal is called a 
pulse. The following figures illustrate the anatomy of a pulse.

 1. A pulse begins when a particle enters the laser beam. At this point, both the beam 
intensity and signal intensity are low.

 2. The pulse reaches a maximum intensity or height when the particle reaches the 
middle of the beam, where the beam and signal intensity are the brightest. The 
peak intensity, or height of the pulse, is measured at this point.

 3. As the particle leaves the beam, the pulse trails off below the threshold.

See the following for more information:
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 l Pulse measurements (page 105)
 l Digital electronics (page 105)
 l Threshold (page 106)
 l Laser controls (page 106)

Pulse measurements

The pulse processors measure pulses by three characteristics: height, area, and width.

 l Height           The maximum digitized intensity measured for the pulse.          
 l Area The integration of all the digitized samples over time, where time is the 

window gate plus 1/2 the window extension added before the initial threshold, plus 
the other half of the window extension value added after the pulse drops below the 
threshold. The window gate extends until the pulse is 75% of the initial threshold.

 l Width The current width is measured by the electronics. 

Digital electronics

BD FACSymphony™ A1 electronics digitize the signal intensity produced by a detector. 
The digitized data is stored in memory and further processed by the electronics to 
calculate:
 l Pulse height and area
 l Compensation
 l Parameter ratios

   105



   BD FACSymphony™ A1 Flow Cytometer User's Guide

These results are transferred to your workstation computer for further processing by 
BD FACSDiva™ software. For more information about digital theory, see Digital Theory 
in the BD FACSDiva™ Software Reference Manual. 

Threshold

The threshold is the level at which the system starts to measure signal pulses. A 
threshold is defined for a specific detector signal. The system continuously samples 
the digitized signal data and calculates pulse area and height for all channels based on 
the time interval during which the threshold is exceeded.

Thresholds can also be set for more than one parameter, and pulse measures are 
based on either of the following:
 l Intervals during which ALL signals exceed their threshold value (AND threshold in 

the software)
 l Intervals during which ANY signal exceeds its threshold value (OR threshold in the 

software)

Laser controls

Controls in the Laser tab of the Cytometer window are used to manually set the (laser) 
delay, area scaling, and window extension values.

These parameters are set by BD Biosciences service personnel during instrument 
installation and performance check and are updated each time you run a performance 
check. 

Note: Do not otherwise change the settings in the Laser tab unless instructed to do so 
by BD Biosciences. Changing the settings affects your data.

See the following screen capture for the correct settings.
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More information
 l Running a performance check (page 67)
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Troubleshooting
This chapter covers the following topics:
 l Cytometer troubleshooting (page 110)
 l Electronics troubleshooting (page 116)
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Cytometer troubleshooting

Introduction

This topic describes possible problems and recommended solutions for 
BD FACSymphony™ A1 flow cytometer issues.

Droplets are visible on the SIT

Possible causes Recommended solutions

Worn O-ring in the retainer Replace the O-ring. See Changing the sample tube O-ring 
(page 59).

Outer sleeve is not seated in 
the retainer

 1. Loosen the retainer.

 2. Push the outer sleeve up into the retainer until seated.

 3. Tighten the retainer.

Outer sleeve is not on the 
sample injection tube

Replace the outer sleeve.

 1. Loosen the retainer.

 2. Slide the outer sleeve over the sample injection tube until 
it is seated.

 3. Tighten the retainer.

Waste line is pinched, 
preventing proper aspiration

Check the waste line.

Waste tank is full Empty the waste tank.

Droplet containment vacuum 
is not functioning

Call your BD service representative.

Acquisition Mode switch set 
to Plate

Make sure Acquisition Mode switch is set to Tube when HTS is 
not attached.

Sample tube not fitting on SIP

Possible causes Recommended solutions

Sample tube other than Use Falcon 12 x 75-mm polystyrene sample tubes. See 
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Possible causes Recommended solutions

Falcon tubes used Equipment (page 143).

Worn Bal seal Replace the Bal seal. See Changing the Bal seal (page 56).

Sample tube is cracked Transfer contents to a new tube.

Rapid sample aspiration

Possible causes                                 Recommended solutions

Support arm is to the side Place the support arm under the sample tube.

Droplet containment module 
is failing

Try the solutions in Droplets are visible on the SIT (page 
110). If the issue is not resolved, call your BD service 
representative.

No events in acquisition display and RUN button is green

Possible causes Recommended solutions

Threshold is not set to the 
correct parameter (usually 
FSC)

Set the threshold to the correct parameter for your 
application.

Threshold level is too high Lower the threshold level. 

PMT voltage for threshold 
parameter is set too low

Set the PMT voltage higher for the threshold parameter. 

Gating issue See the BD FACSDiva™ Software Reference Manual for 
information on setting gates.

Air in the sheath filter Purge the filter. See Removing air bubbles (page 34).

Air bubble or debris in the 
flow cell

Prime the fluidics system. See Preparing the fluidics (page 
39).

No sample in the tube Verify that sample remains in the tube and if necessary, add 
sample to the tube or install a new sample tube.

Sample is not mixed properly Mix the sample to suspend the cells.

Waste tank is full Empty the waste tank.
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Possible causes Recommended solutions

PMT voltages set too low or 
too high for display 
parameter

Adjust the PMT voltages.

Too few events are displayed Increase the number of events to display.

Sample injection tube is 
clogged

Remove the sample tube to allow backflushing.

If the event rate is still erratic, clean the sample injection 
tube. See Cleaning the fluidics (page 47).

Bal seal is worn Replace the Bal seal. See Changing the Bal seal (page 56).

Instrument is not warmed up Wait 30 minutes for the instrument to warm up.

Laser is not functioning Verify the malfunction by changing the threshold to an 
alternative laser while running the appropriate sample. If 
unsuccessful, contact BD Biosciences.

Tube is cracked or misshapen Replace the sample tube.

Waste tank is pressurized. Disconnect the waste container for 
at least 30 seconds to allow the pressure to dissipate.

No events in acquisition display and RUN button is orange

Possible causes Recommended solutions

RUN is not activated Press the RUN button.

Sample tube is not installed 
or is not properly seated

Install the sample tube correctly on the SIP.

Sample tube is cracked Replace the sample tube.

Waste tubing line is 
disconnected from the waste 
container tank 

Connect the waste tubing line to the waste container tank.

Sheath container is not 
pressurized

 l Ensure that the sheath container lid and all connectors are 
securely seated.

 l Inspect the sheath container O-ring inside the lid and 
replace it if necessary. See Cleaning or replacing the 
sheath gasket  (page 60)
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Possible causes Recommended solutions

Bal seal is worn Replace the Bal seal. See Changing the Bal seal (page 56).

Air leak at sheath container Ensure that the sheath container lid and all connectors are 
securely seated.

Sheath container is empty Fill the sheath container.

Air in sheath filter Purge the filter. See Removing air bubbles (page 34).

No fluorescence signal

Possible causes Recommended solutions

Incorrect fluorochrome 
assignment

Make sure that the cytometer configuration in the software 
matches the optical filters in the cytometer and the 
configuration is as expected.

Laser is not functioning Call your BD service representative.

No signal in red laser channels (when red laser is installed)

Possible causes Recommended solutions

Incorrect laser delays due to 
a change in the sheath tank 
fluid level

 l Check the fluid level in the sheath tank and refill if 
necessary.

High event rate

Possible causes Recommended solutions

Air bubbles in the sheath 
filter or flow cell

Remove the air bubbles. See Removing air bubbles (page 34).

Threshold level is too low Increase the threshold level. See the BD FACSDiva™ Software 
Reference Manual for instructions.

PMT voltage for the threshold 
parameter is set too high

Set the PMT voltage lower for the threshold parameter. 

Sample is too concentrated Dilute the sample.
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Possible causes Recommended solutions

Sample flow rate is set to 
HIGH

Set the sample flow rate to MED or LOW.

Low event rate

Possible causes Recommended solutions

Threshold level is too high Lower the threshold level. See the BD FACSDiva™ Software 
Reference Manual for instructions.

Air bubble or debris in the 
flow cell

Prime the fluidics system. See Preparing the fluidics (page 
39).

PMT voltage for the threshold 
parameter is set too low

Set the PMT voltage higher for the threshold parameter. See 
the BD FACSDiva™ Software Reference Manual for 
instructions.

Sample is not adequately 
mixed

Mix the sample to suspend the cells.

Sample is too diluted Concentrate the sample. If the flow rate setting is not critical 
to the application, set the flow rate switch to MED or HIGH.

Sample injection tube is 
clogged

Remove the sample tube to allow backflushing.

If the event rate is still erratic, clean the sample injection 
tube. See Cleaning the fluidics (page 47).

Erratic event rate

Possible causes Recommended solutions

Sample tube is cracked Replace the sample tube.

Air bubble or debris in the 
flow cell

Prime the fluidics system. See Preparing the fluidics (page 
39).

Bal seal is worn Replace the Bal seal. See Changing the Bal seal (page 56).

Sample injection tube is 
clogged

Remove the sample tube to allow backflushing.

If the event rate is still erratic, clean the sample injection 
tube. See Cleaning the fluidics (page 47).
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Possible causes Recommended solutions

Contaminated sample Prepare the specimen again. Ensure that the tube is clean.

Sheath filter is dirty Replace the filter. See Changing the sheath filter (page 52).

Distorted scatter parameters

Possible causes Recommended solutions

Cytometer settings are 
improperly adjusted

Optimize the scatter parameters. See the BD FACSDiva™ 
Software Reference Manual for instructions.

Air bubble in the sheath filter 
or flow cell

Purge the air from the filter. See Removing air bubbles (page 
34).

Flow cell is dirty Flush the system. See Flushing the system (page 49).

Air leak at sheath container Ensure that the sheath container lid is tight and all 
connectors are secure.

Hypertonic buffers or fixative Replace the buffers or fixative.

Excessive amount of debris in display

Possible causes Recommended solutions

Threshold level is too low Increase the threshold level.

Sheath filter is dirty Replace the filter. See Changing the sheath filter (page 52).

Flow cell is dirty Flush the system. See Flushing the system (page 49).

Dead cells or debris in the 
sample

Examine the sample under a microscope.

Sample is contaminated Re-stain the sample. Ensure that the tube is clean.

Stock sheath fluid is 
contaminated

Rinse the sheath container with DI water, then fill the 
container with sheath fluid from another (or new lot) bulk 
container.
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High CV or poor QC results

Possible causes Recommended solutions

Air bubble in sheath filter or 
flow cell

 l Purge the filter. See Removing air bubbles (page 34).

 l Prime the fluidics system. See Preparing the fluidics (page 
39).

Sample flow rate is set too 
high

Set the sample flow rate lower.

Air leak at sheath container Ensure that the sheath container lid is tight and all 
connectors are secure.

Flow cell is dirty Flush the system. See Flushing the system (page 49).

Waste tank is pressurized Replace the waste container cap. See Replacing the waste 
tank cap (page 50).

Poor sample preparation Repeat sample preparation.

Sample was not diluted in the 
same fluid as the sheath fluid

Dilute the sample in the same fluid as you are using for 
sheath.

Old or contaminated QC 
particles

Make new QC samples and perform the quality control 
procedure again.

Instrument is not warmed up Wait 30 minutes for the instrument to warm up.

Laser is not functioning Contact BD Biosciences.

Optical alignment problem Contact BD Biosciences.

Electronics troubleshooting

Introduction

This topic describes possible problems and recommended solutions for 
BD FACSymphony™ A1 electronics issues.
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“Cytometer Disconnected” in cytometer window

Possible causes Recommended solutions

Cytometer power is off Turn on the cytometer main power.

Communication failure 
between workstation and 
cytometer

 1. In BD FACSDiva™ software, select Cytometer > Connect.

 2. If connecting does not work, restart the cytometer. Turn the 
cytometer off, wait 1 minute, and turn on the cytometer 
main power.

 3. If connecting still does not work, contact BD Biosciences.
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Detector array configurations
This chapter covers the following topics:
 l Fluorescence spectra (page 120)
 l About configuration maps (page 122)
 l About configurations (page 122)
 l Base configuration polygon maps (page 123)
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Fluorescence spectra

Introduction

This topic shows sample emission spectra from common fluorochromes, as well as the 
more common laser excitation lines. This information is useful for designing multicolor 
panels. An interactive fluorescence viewer is available at bdbiosciences.com. You can 
also look for training by selecting Support > Training.

Designing multicolor panels

The BD FACSymphony™ A1 flow cytometer is designed specifically for multicolor 
research. Results depend on the excitation and emission spectra of the individual dye, 
the number of fluorescently labeled binding sites on the cell, as well as spectral 
overlap and spillover to other detectors. For more information about designing 
multicolor panels, see Selecting Reagents for Multicolor Flow Cytometry 
(Part No. 23-9538-02).

Example laser and dye interactions

The following figures show the emission spectra of some common dyes, based on laser 
excitation. In many cases, a given dye can be excited by multiple laser wavelengths, 
yielding different emission intensities.

1
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2

3

4

No Definition 

1 Violet (405 nm)

2 Blue (488 nm)

3 Yellow-Green (561 nm) 

4 Red (637 nm)
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About configuration maps

Filter and mirror arrangement

The filters are arranged in the detector array to steer progressively shorter 
wavelengths of light to the next detector in the array. The longest wavelength should 
be in the A position and the shortest wavelength should be in the last position used. 

There should not be any empty slots for any laser being used. Always use a blank optic 
holder. 

If a slot is filled with a filter or mirror, an identifying number appears in that position 
on the configuration map. If a slot is filled with a blank optic holder, that position on 
the configuration map is unlabeled.

About configurations

Available configurations

The configurations for the BD FACSymphony™ A1 flow cytometer supports detectors, 
filters, and mirrors for  four lasers to provide either 14 or 16 colors. The Small Particle 
Detector can be added to either the 14 or 16 color configuration.

Colors Configuration Small Particle 

Detector

14 2-Blue 2-Red 4-Yellow-green 6-Violet No

14 2-Blue 2-Red 4-Yellow-green 6-Violet SP Yes

16 2-Blue 3-Red 5-Yellow-green 6-Violet No

16 2-Blue 3-Red 5-Yellow-green 6-Violet SP Yes

Base configuration

The BD FACSymphony™ A1 flow cytometer has one base configuration at installation. 
The following image shows a default base cytometer configuration.
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More information
 l Verifying the configuration and user preferences (page 65)

Base configuration polygon maps

About the maps

The tables and maps in this section show the detectors, filters, and mirrors used for 
each laser, and recommended fluorochromes for each detector.  A dash (—) indicates 
that no slot exists for a mirror in that detector position. 
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Six-color violet laser configuration

The following table and map show the six-color configuration for the 405-nm violet 
laser. The optional 431/28 BP filter can be found in the accessory kit.

Laser Detector LP mirror BP filter Fluorochromes

 

Violet

405 nm

 

A 750 780/60 BD Horizon™ BV786

B 690 710/50 BD Horizon™ BV711

C 655 670/30 BD Horizon™ BV650

D 595 610/20 BD Horizon™ BV605

E 505 525/50 BD Horizon™ BV480

F

 

410 450/50 BD Horizon™ BV421, 
BD Horizon™ V450, 
Pacific Blue™

 F 410 Optional: 
431/28

124   



Chapter 9  Detector array configurations

Two-color blue laser configuration

The following table and map show the two-color configuration for the 488-nm blue 
laser.

Note: Detector F is used only when the optional Small Particle Dectector installed.

Laser Detector LP mirror BP filter Fluorochromes

Blue

488 nm

 

B 690 710/50 BD Horizon™ BB700, 
PerCP-Cy5.5, 7-AAD

C 505 530/30 BD Horizon™ BB515, 
Alexa Fluor™ 488, FITC

E _ 488/10 SSC

F _ _ SP SSC
Only when SPD installed
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Five-color yellow-green laser configuration

The following table and map shows the five-color configuration for the 561-nm yellow-
green laser. 

Note: The folowing table and map are for the 16-color configuration.

Laser Detector LP mirror BP filter Fluorochromes

 

Yellow-Green

561 nm

 

 

A 750 780/60 PE-Cy7

B 690 710/50 PE-Cy5.5

C 655 670/30 PE-Cy5

D 595 610/20 BD Horizon™ PE-CF594, 
PE-Texas Red, PI

E 580 586/15 PE
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Three-color red laser configuration

The following table and map shows the three-color configuration for the 637-nm red 
laser. 

Note: The following table and map are for the 16-color configuration.

Laser Detector LP mirror BP filter Fluorochromes

 

Red

637 nm

 

 

A 750 780/60 AP-Cy7, 
BD Horizon™ APC-H7

B 690 710/50 BD Horizon™ APC-R700, 
Alexa Fluor™ 700

C 655 670/30 APC, Alexa Fluor™ 647

 

More information
 l About configurations (page 122)
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Small Particle Detector
This chapter covers the following topics:

 l Preparing the system for small particle detection (page 130)

 l Confirming small particle detection (page 131)

 l Aligning the small particle detector  (page 137)

 l Small particle detector troubleshooting (page 139)
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Preparing the system for small particle 
detection

Overview

The BD® Small Particle Detector (SPD) is an optional side scatter detector optimized 
to enhance resolution of small particles such as extracellular vesicles. This device can 
be included as an option on a new system.

Note: The SPD is a separate device installed inside the BD FACSymphony™ A1 flow 
cytometer, and the output is captured on the blue laser detector array. For more 
information, see the blue laser configuration map in Base configuration polygon maps 
(page 123).

Before you begin

Ensure you install a sheath filter with a smaller pore size than the particle of interest 
you wish to detect. For the procedures in this user's guide working with small particle 
detection, we use a Meisnner 0.040 µm sheath filter, see Equipment (page 143) for 
part number. When you install a new sheath filter, make sure you run at least 500 mL 
of sheath fluid through the sheath filter into a container before running the sheath 
fluid through the system. See Changing the sheath filter (page 52).

Ensure diluents and buffers that are run on the system are filtered to at least the 
same pore size as the sheath filter and are made fresh each day.  For the procedures in 
the small particle detector section of the user’s guide, 20 nm-filtered 1X PBS was used.

The small particle detection setup is designed to work with a sheath tank and 
BD FACSFlow™ sheath fluid. Small particle detection is not recommended for use with 
BD FACS™ Sheath Solution with Surfactant, HTS, or the FFSS options.

Procedure

 1. If a system flush has not been performed in the last two weeks, perform one. See 
Flushing the system (page 49)

 2. Turn on the cytometer.

 3. Allow the lasers to warm up for 30 minutes before proceeding.
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 4. While the lasers are warming up, install a tube containing 3 mL of filtered PBS. 
Press RUN and HIGH on the cytometer fluid control panel. Run for 30 minutes.

 5. Ensure you are using a cytometer configuration with the windows extension set to 
2.

 6. Run a CS&T performance check with the tank half full to ensure proper laser delay 
setup with a window extension of 2. Fill the tank after CS&T is complete.

Note: If CS&T is performed with a full tank, refill the tank when it reaches 50% to 
maintain laser proper laser delays.

 7. Install a tube with 3 mL of a 1.5% dilution of BD Detergent Solution Concentrate 
on the SIP with the tube support arm to the side (vacuum on) and let it run for 1 
minute.

Note: The BD Detergent Solution Concentrate must be diluted before use. Mix one 
full 15 mL bottle of BD Detergent Solution Concentrate into 985 mL of DI water to 
make 1 L total.

Caution: Never mix BD Detergent Solution and bleach because they create 
chlorine gas.

 8. Move the tube support arm under the tube (vacuum off) and run 1.5% dilution of 
BD Detergent Solution Concentrate for 15 minutes.

 9. Install a tube containing 3 mL of filtered PBS on the SIP with the tube support arm 
to the side (vacuum on) and let it run for 1 minute.

 10. Move the tube support arm under the tube (vacuum off) and run filtered PBS for 
30 minutes.

Confirming small particle detection

Recommended beads 

These are the recommended beads for calibration of the SPD.

 l MegaMix SSC Beads – Biocytex – 7803

 l Nanosphere 90nm beads - ThermoFisher Scientific - 3090A
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Creating the recommended bead mixture

To confirm small particles can be differentiated from noise signals, first mix the 
following small particle calibration beads.

 1. Combine 5 mL filtered PBS (phosphate buffered saline) + 5 µL of NIST 90 nm 
beads. Label this 1:1000 NIST 90 nm bead mixture.

 2. Vortex the mixture.

 3. Combine 1980 µL filtered PBS + 20 µL of 1:1000 NIST 90 nm bead mixture to 
create a 1:100,000 NIST 90 nm bead mixture. Label this 1:100,000 NIST 90 nm 
bead mixture.

 4. Vortex the mixture.

 5. Mix 450 µL MegaMix beads + 50 µL of 100,000 to 1 NIST 90 nm beads and label 
MegaMix/NIST mixture. The final dilution of NIST beads should be 1:10^6.

 6. Vortex briefly to mix. The bead mixture is ready for analysis.

Analyzing the bead mixture

 1. Prepare the bead mixture and two fresh tubes of 3 mL filtered PBS (diluent 
background). Ensure the filtered PBS used for your bead mixture and your 
background are from the same filtered stock.

 2. Create a new experiment and add a specimen.

 3. Create the following plots, gates, and statistics. Ensure Height and Log are 
selected for FSC, SSC, SP SSC, and BB515.
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 4. Rename the tube MegaMix/NIST beads..

 5. Set the threshold at 200 on the SP-SSC channel.

 6. Ensure the window extension in the cytometer configuration is set to 2.00.

 7. For starting voltages, use CS&T settings for all setting except SP-SSC. Set the SP-
SSC voltage to 480.

 8. Press RUN and LOW on the cytometer fluid control panel.

 9. Install the MegaMix/NIST mixture and acquire data.
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 10. Examining the BB515-H vs SSC-H plot, adjust the BB515 and SSC voltages so you 
can gate the 160 nm and 200 nm bead populations. These will be the two smallest 
bead populations visible on this plot. NIST (90 nm) beads are not fluorescent.

 11. Confirm you can identify which peak is the 200 nm bead peak on the SP-SSC 
histogram plot by displaying only the 200 nm bead gate.

 12. Display All Events on the SP-SSC-H histogram plot and adjust the SP-SSC-H voltage 
so that the 200 nm bead median fluorescence intensity is around 100,000.

 13. Examining the SP-SSC-H histogram plot, if the 90 nm, 160 nm, or 200 nm bead 
peaks are overlapped, or the 90 nm bead peak is merging with the background, 
perform an alignment of the small particle detector prior to continuing this 
procedure. After aligning, confirm the 200 nm bead median fluoresence intensity is 
around 100,000. Adjust the SP-SSC voltage if needed. See Confirming small 
particle detection (page 131). If the peaks are well separated and defined, 
continue to step 14.  

The following screenshot is an example of a poorly aligned small particle detector. 
Step 3 shows data from a properly aligned small particle detector.
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 14. Increase the SP-SSC threshold level to eliminate most of the noise peak. Ensure 
the entirety of the 90 nm peak is fully visible and the valley the 90 nm peak and 
the start of the noise peak is visible.

 15. Record 1 minute of data in the MegaMix/NIST Beads sample in the Browser

 16. Remove the bead tube.

 17. Clean the beads out of the system.

 a. Wipe the outside of the SIT sleeve with a delicate task wipe.

 b. Press HIGH on the cytometer fluid control panel.
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 c. Install a tube containing 3 mL of filtered PBS on the SIP with the tube support 
arm to the side (vacuum on) and let it run for 1 minute.

 d. Move the tube support arm under the tube (vacuum off) and run PBS for 1 
minute.

Analyzing the background noise

 1. Press RUN and LOW on the cytometer fluid control panel.

 2. Install a fresh filtered PBS tube and acquire data.

 3. Add a new tube and rename it PBS Background. 

 4. Record 1 minute of data in the PBS Background sample in the Browser.

 5. Compare the SP-SSC-H histogram from the PBS Background tube to the histogram 
from the MegaMix/NIST tube and confirm that the bead peaks can be 
differentiated from each other and from the background noise, as shown in the 
following plot. 
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Aligning the small particle detector 
The New Focus Picomotor application can be used to align the SPD if needed. 

To use the New Focus Picomotor Application:

 1. Open the New Focus Picomotor Application by double-clicking the icon on the 
desktop.

 2. In the Controller area in the upper left of the dialog, select the Controller, as 
shown in the following screen capture.

   137



   BD FACSymphony™ A1 Flow Cytometer User's Guide

 3. In the Motor area, you can select the motors that are configured for your system. 
Typically Motor 1 is for the X direction and Motor 2 is for the Y direction. If Motors 
1 and 2 do not respond, try Motors 3 and 4.

 4. The Position Status shows the relative position of the motors. Zero the positions so 
you have a reference established for                       the starting point.

 5. Select Relative mode and set the steps value to 1000, as highlighted in the 
following screen capture.
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 6. In the Relative steps area, you can select - (minus) or + (plus) to move the motor 
stage in small increments.

 7. While acquiring your bead mixture and examining the SP SSC-H v BB515-H plot 
and SP-SSC-H histogram, move the motors one step at a time. The SPD is aligned 
when the bead peaks are tight and well separated.

 8. After alignment, close the New Focus Picomotor Application and return to Aligning 
the small particle detector  (page 137).

 

Small particle detector troubleshooting

Event rate or background noise is higher than expected 

Possible causes Recommended solutions

If instrument is in STANDBY 
mode, there may be air 
bubbles in the system.

Put system into RUN mode and acquire filtered PBS until the 
event rate stabilizes.

 l Ensure that the sheath container lid and all connectors are 
securely seated.

 l Inspect the sheath container O-ring inside the lid and 
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Possible causes Recommended solutions

replace it if necessary.

If instrument is in RUN mode, 
there may be leftover beads 
in the system.

Clean the SIP and sample path of beads:

 1. Press RUN and HIGH on the cytometer fluid control panel.

 2. Wipe the outside of the SIT sleeve with a delicate task 
wipe.

 3. Install a tube containing 3 mL of filtered PBS on the SIP 
with the tube support arm to the side (vacuum on) and let 
it run for 1 minute.

 4. Move the tube support arm under the tube (vacuum off) 
and run PBS for 1 minute.

Your sample diluent may be 
the source of the noise.

 l Ensure you are filtering at the same size as your sheath 
filter, or filter at a small size.                             

 l Switch diluents

 l Perform a system flush

 l Change the sheath filter

BD CS&T fails after running small particles

Possible causes Recommended solutions

There may be leftover beads 
in the system

Clean the SIP and sample path of beads:

 1. Press RUN and HIGH on the cytometer fluid control panel.

 2. Wipe the outside of the SIT sleeve with a delicate task 
wipe.                             

 3. Install a tube containing 3 mL of filtered PBS on the SIP 
with the tube support arm to the side (vacuum on) and let 
it run for 1 minute.

 4. Move the tube support arm under the tube (vacuum off) 
and run PBS for 1 minute.
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Supplies and consumables
This chapter covers the following topics:
 l Ordering information (page 142)
 l Beads (page 142)
 l Reagents (page 143)
 l Equipment (page 143)
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Ordering information
To order spare parts and consumables from BD Biosciences:
 l Within the US, call (877) 232-8995.
 l Outside the US, contact your local BD Biosciences customer support representative.

Worldwide contact information can be found at bdbiosciences.com.

Beads

Introduction

This topic lists the QC and CS&T beads available.

QC particles

Particle Laser Supplier Catalog 

No.

SPHERO™ Rainbow Calibration Particles 
(8 peaks)

Blue, Violet, Yellow-
Green and Red

BD Biosciences 559123

SPHERO Ultra Rainbow Fluorescent 
Particles (single peak)

Blue, Violet, Yellow-
Green and Red

Spherotech, 
Inc.

URFP-
30-2

BD DNA QC Particles Blue (488 nm) BD Biosciences 349523

CS&T beads

Bead Laser Supplier Catalog No.

BD FACSDiva™ 2.0 CS&T research 
beads

 l Violet (405 nm)

 l Blue (488 nm)

 l Red (637 nm)

 l Yellow-green 
(561 nm)

BD Biosciences  l 655050 
(50 tests)

 l 655051 
(150 tests)
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Reagents
Reagent Supplier Catalog No.

MegaMix SSC Beads Biocytex 7803

Nanosphere 90nm beads ThermoFisher Scientific 3090A

BD FACSFlow™ sheath 
fluid

BD Biosciences 342003 

BD FACS™ sheath 
solution with surfactant 
(recommended for use 
with the HTS option)

BD Biosciences 336524 (USA), 

336911 (Europe)

Monoclonal antibodies BD Biosciences See the BD Biosciences 
Product Catalog or the 
BD Biosciences website 
(bdbiosciences.com)

BD FACS™ lysing solution BD Biosciences 349202

BD Detergent Solution 
concentrate

BD Biosciences 660585

BD FACSClean™ solution BD Biosciences 340345

Dyes and fluorochromes BD Biosciences, Sigma, or Life 
Technologies

–

Chlorine bleach 
(5% sodium hypochlorite)

Clorox® or other major supplier (to 
ensure that the bleach is at the 
correct concentration and free of 
particulate matter)

–

Equipment
Equipment item Supplier Catalog No.

Bal seal BD Biosciences

 

343509

O-ring, sample tube BD Biosciences 343615
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Equipment item Supplier Catalog No.

Sheath filter assembly BD Biosciences 34364507

Meissner 0.04 µm filter BD Biosciences 665397

Falcon polystyrene test tubes, 12 x 75-mm Corning
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Index
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405-nm violet laser  124
488-nm blue laser  125

5

571-nm yellow-green laser  126

6

637-nm red laser  127

A

acridine orange (AO)  47
air bubbles, removing  34
alarm

waste container  25
Alexa Fluor  125, 127
analysis

data  84
reusing  93
saving  93

antibodies  98
AO See acridine orange  47
application settings

applying  85
creating  76

aspiration (sample), rapid  111
assistance, technical  11

B

Bal seal
ordering  143
replacing  56

bandpass (BP) filters
detector array placement  27
theory  100

BD FACSClean  46, 49
BD FACSClean solution  143
BD FACSDiva software See 

software  10
BD FACSFlow sheath fluid  143
BD FACSFlow solution  33
BD FACSFlow supply system  30, 48
BD FACSymphony A1

configurations  123
documentation  11
flow cytometer overview  14
lasers and optics  26
small particle detector  130

BD High Throughput Sampler (HTS)  14, 
18, 24

BD Horizon fluorochromes  124
blank optical holders  41
bleach  46, 143
BP See bandpass filters  27
bubbles, removing air  34
buttons

fluid control  19
sample flow rate control  20
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C

calculating compensation  80
capacity, waste container  25
cleaning solutions  46
compensation

calculating  80
control tubes  77
recording settings  78
theory  101

components
sheath container shown  32
sheath filter shown  53
waste container shown  36

computer system, about  28
configuration

BD FACSDiva  65
containers

sheath  25, 31
waste  25, 36, 39

control panel, cytometer  17
controls

fluidics  17
single-stained  65, 84

conventions
safety symbols  10

creating
analysis objects  88
global worksheets  85
statistics view  88

CS&T beads  142
CV, troubleshooting  116

cytometer  15
configuration  42, 65
disconnect error  117
setup  64
starting  30
troubleshooting  110

D

Daily cleaning  47
DAPI, cleaning after using  47
data

analyzing  84, 88
gating  88
recording  84, 86

debris, excessive  115
detector arrays  26
detectors  27
dichroic mirrors

theory  101
digital data  15
digital electronics  105
Diva software See software  10
DNA, flow rate for analysis  97
droplet containment system  25

E

electronics
digital  105
laser controls  106
pulse  104
pulse measurements  105
threshold  106
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troubleshooting  116
emission duration  104
event rate

erratic  114
high  113
low  114
zero  111-112

excessive debris  115
excitation wavelength  98
experiments

creating  70
immunophenotyping  85
sample optimization  70
specifying parameters  71

F

FACSClean  46, 49, 143
FACSFlow sheath fluid  143
FACSFlow solution  33
Falcon tubes  110
filters, optical

bandpass (BP)  27, 100
dichroic See dichroic mirrors  101
longpass (LP)  99
notch  99
shortpass (SP)  99
theory  98

filters, sheath
attaching new  54-55
replacing  52

FITC and Stokes shift  98
fixed-alignment lasers  15

flow cell
draining  39
fluidics  96

flow rate control buttons  20
fluid control buttons

PRIME  19
RUN  19
STANDBY  19

fluidics
description  18, 96
flow rate control  20
flushing system  49
preparing  39
removing air bubbles  34
run mode  19
sample injection port (SIP)  23-24

fluidics controls, cytometer  17
fluidics interconnect  36
fluorescence

defined  98
emission  104

fluorescence signal, none  113
fluorochromes

compensation theory  101
measured  42
role in light emission  98

flushing the system  49
forward scatter (FSC)  97
FSC See forward scatter  97

G

gating data  88
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global worksheets
analyzing data  88
creating  85
previewing data  84, 93

H

hazard symbol definitions  10
Help, accessing  11
High Throughput Sampler (HTS)  14, 

18, 24, 130
Horizon fluorochromes  124
hydrodynamic focusing  96

I

immunophenotyping
analysis  88
experiment  85
hydrodynamic focusing  97

L

lasers
performance check  67
quality control (QC) particles  142
wavelengths and power  26

longpass (LP) filters
defined  99
theory  99

LP See longpass filters  99

M

maintenance
Bal seal  56

cytometer shutdown  48
replacing waste tank cap  50
sample tube O-ring  59
schedule  46
sheath filter  52
system flush  49

mirrors, dichroic longpass (LP) filter  27

N

notch filters  99

O

O-ring
ordering  143
replacing  59
worn  110

online Help  11
optic holder  41
optics

components  26
configuration  65-66
dichroic mirrors  101
filters  27, 98

optimization, sample  64
ordering spare parts  142

P

Pacific Blue fluorochrome  124
particles  142
PerCP, Stokes shift  98
performance check  67
photodiode  27
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photomultiplier tubes (PMTs)  27
PMT See photomultiplier tubes  27
population hierarchy  88
PRIME, fluid control button  19
priming fluidics system  39
propidium iodide (PI)  47
pulse

definition  104
measurements  105
processors  105

Q

quality control (QC)
particles  142
troubleshooting  116

R

recording
compensation settings  78
compensation tubes  77
data  84, 86

removing air bubbles, filter  34
replacing

Bal seal  56
sample tube O-ring  59
sheath filter  52
waste air filter  60
waste tank cap  50

reusing analyses  93
RUN

button orange  112
fluid control button  19

S

safety symbol definitions  10
safety symbols  10
sample

optimization  64
optimization experiment  70
optimization, single-stained 

controls  65, 84
sample injection port (SIP)

components  23-24
hydrodynamic focusing  96
replacing Bal seal  56
replacing sample tube O-ring  59

sample tube
injection  24
not fitting  110
requirements  110

samples, running  86
saving analyses  93
scatter

light  97
parameter distortion  115

setup, cytometer  64
sheath

flow  96
sheath container

components shown  32
defined  25
preparing  33

sheath filter
components shown  53
ordering  144
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removing air bubbles  34
replacing  52

sheath fluid  96
BD FACSFlow sheath fluid  143

sheath tank
depressurize  33

shortpass (SP) filters  99
side scatter (SSC)  97
signals, amplifying  27
SIP See sample injection port  96
small particle detector

bead mixture  132
overview  130
Picomotor application  137
recommended beads  131
troubleshooting  139

software
cytometer control  10
version  28

spare parts, ordering  142
spillover  102
SSC See side scatter  97
STANDBY, fluid control button  19
starting cytometer  30
statistics views  88
Stokes shift  98
support, technical  12

T

technical assistance  11
thiazole orange (TO)  47
threshold, defined  106

TO See thiazole orange  47
troubleshooting

cytometer  110
electronics  116
small particle detector  139

tubes
Falcon  110
requirements  110

U

user preferences  67

W

waste air filter
component  shown  36

waste container  25
alarm  25
capacity  25
components shown  36
defined  25
emptying  36

workstation, about  28





Becton, Dickinson and Company
BD Biosciences
2350 Qume Drive
San Jose, CA 95131 USA
 
BD Biosciences
European Customer Support
Tel +32.53.720.600
help.biosciences@bd.com
 
 
bdbiosciences.com
ResearchApplications@bd.com
 

mailto:help.biosciences@bd.com
https://www.bdbiosciences.com/
mailto:ResearchApplications@bd.com

	1  About this guide
	What this guide covers
	Conventions
	About the BD FACSymphony™ A1 documentation
	Instrument technical support

	2  Introduction
	System overview
	Cytometer overview
	Control panel
	Fluidics system
	Sheath and waste tanks
	Optics
	Workstation

	3  Cytometer setup
	Starting the cytometer and computer
	Preparing the sheath tank
	Removing air bubbles
	Preparing the waste tank
	Preparing the fluidics
	About the optical filters and mirrors
	Custom configurations and baselines

	4  Maintenance
	Maintenance overview
	Cleaning the fluidics
	Shutting down the cytometer
	Flushing the system
	Replacing the waste tank cap
	Changing the sheath filter
	Changing the Bal seal
	Changing the sample tube O-ring
	Cleaning or replacing the sheath gasket
	Accessing the red laser detector array

	5  Optimizing cytometer settings
	Cytometer settings workflow
	Verifying the configuration and user preferences
	Running a performance check
	Setting up an experiment
	Creating application settings
	Recording compensation controls
	Calculating compensation

	6  Recording and analyzing data
	Data recording and analysis workflow
	Preparing the workspace
	Recording data
	Analyzing data
	Reusing an analysis

	7  Technical overview
	About fluidics
	About optics
	About electronics

	8  Troubleshooting
	Cytometer troubleshooting
	Electronics troubleshooting

	9  Detector array configurations
	Fluorescence spectra
	About configuration maps
	About configurations
	Base configuration polygon maps

	10  Small Particle Detector
	Preparing the system for small particle detection
	Confirming small particle detection
	Aligning the small particle detector
	Small particle detector troubleshooting

	11  Supplies and consumables
	Ordering information
	Beads
	Reagents
	Equipment

	Index

